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I n t r o d u c t i o n

Welcome to the Material Library, an add-on product that provides predefined 
material data, primarily as piecewise polynomial functions of temperature. The 
Material Library contains more than 30,000 property functions; these functions 
specify various material properties of over 3800 materials.

The Material Library is ideal for multiphysics couplings such as electrical-thermal 
analysis and structural-thermal analysis because most of the properties are available 
as functions of temperature.
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T h e  Ma t e r i a l  L i b r a r y  En v i r o nmen t

When working with the Material Library, it is the same as working with any other 
material database. Below are descriptions about the predefined material databases, the 
Material Library folders, and the windows and pages you work in to add any material 
to your model.

About the Material Library 

The Material Library stores the material data in folders. A search engine on the Material 

Browser makes it easy to find materials to add to models — you can search by name, 
UNS number, or DIN number.

The following is some basic information about the available material properties 
contained in the Material Library. 

• The Material Library incorporates mechanical, thermal, and electrical properties 
primarily for solid materials.

• The material properties are described as a function of some variable, typically 
temperature, and focus on elastic and thermal properties.

• Where applicable, data is given for a material’s solid, liquid, and vapor phases. A 
material can also contain data for multiple orientations or variations.

• The properties are analytic functions over a given interval of the argument.

• Smoothing is used to interpolate the values of the properties between different 
intervals. You can choose the smoothing settings in order to obtain continuous first 
and second derivatives of the property functions.

• Materials can be copied to a User-Defined Library where you can add and edit 
properties. You can also plot and inspect the definition of a function.

• The material property data in the Material Library is based on the Material Property 
Database (MPDB) from JAHM Software, Inc.

• For all properties contained in the Material Library, you can view the literature 
reference, notes, and reference temperature (where applicable) by first selecting a 

See Materials in the COMSOL Multiphysics Reference Manual for an 
overview of working with material properties, material databases, and the 
Material Browser.
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material property and then on the Material Browser, under Properties, click a specific 
property. Then information, when available, displays under Property reference.

Where Do I Access the Documentation and Application Libraries?

A number of internet resources have more information about COMSOL, including 
licensing and technical information. The electronic documentation, topic-based (or 
context-based) help, and the application libraries are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N  A N D  O N L I N E  H E L P

The COMSOL Multiphysics Reference Manual describes the core physics interfaces 
and functionality included with the COMSOL Multiphysics license. This book also has 
instructions about how to use COMSOL Multiphysics and how to access the 
electronic Documentation and Help content.

Opening Topic-Based Help
The Help window is useful as it is connected to the features in the COMSOL Desktop. 
To learn more about a node in the Model Builder, or a window on the Desktop, click 
to highlight a node or window, then press F1 to open the Help window, which then 

• Working with Materials

• The Material Browser Window

• The Add Material Window

If you are reading the documentation as a PDF file on your computer, 
the blue links do not work to open an application or content 
referenced in a different guide. However, if you are using the Help 
system in COMSOL Multiphysics, these links work to open other 
modules, application examples, and documentation sets.
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displays information about that feature (or click a node in the Model Builder followed 
by the Help button ( ). This is called topic-based (or context) help.

Opening the Documentation Window

To open the Help window:

• In the Model Builder, Application Builder, or Physics Builder click a node or 
window and then press F1. 

• On any toolbar (for example, Home, Definitions, or Geometry), hover the 
mouse over a button (for example, Add Physics or Build All) and then 
press F1.

• From the File menu, click Help ( ).

• In the upper-right corner of the COMSOL Desktop, click the Help ( ) 
button.

To open the Help window:

• In the Model Builder or Physics Builder click a node or window and then 
press F1.

• On the main toolbar, click the Help ( ) button.

• From the main menu, select Help>Help.

To open the Documentation window:

• Press Ctrl+F1.

• From the File menu select Help>Documentation ( ).

To open the Documentation window:

• Press Ctrl+F1.

• On the main toolbar, click the Documentation ( ) button.

• From the main menu, select Help>Documentation.
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T H E  A P P L I C A T I O N  L I B R A R I E S  W I N D O W

Each model or application includes documentation with the theoretical background 
and step-by-step instructions to create a model or application. The models and 
applications are available in COMSOL Multiphysics as MPH files that you can open 
for further investigation. You can use the step-by-step instructions and the actual 
models as templates for your own modeling. In most models, SI units are used to 
describe the relevant properties, parameters, and dimensions, but other unit systems 
are available.

Once the Application Libraries window is opened, you can search by name or browse 
under a module folder name. Click to view a summary of the model or application and 
its properties, including options to open it or its associated PDF document.

Opening the Application Libraries Window
To open the Application Libraries window ( ):

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

C O M S O L  A C C E S S  A N D  T E C H N I C A L  S U P P O R T

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 

The Application Libraries Window in the COMSOL Multiphysics 
Reference Manual.

• From the Home toolbar, Windows menu, click ( ) Applications 

Libraries.

• From the File menu select Application Libraries.

To include the latest versions of model examples, from the File>Help 
menu, select ( ) Update COMSOL Application Library.

Select Application Libraries from the main File> or Windows> menus.

To include the latest versions of model examples, from the Help menu 
select ( ) Update COMSOL Application Library.
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support@comsol.com. An automatic notification and a case number are sent to you by 
email. You can also access technical support, software updates, license information, and 
other resources by registering for a COMSOL Access account.

C O M S O L  O N L I N E  R E S O U R C E S

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com/contact

COMSOL Access www.comsol.com/access

Support Center www.comsol.com/support

Product Download www.comsol.com/product-download

Product Updates www.comsol.com/support/updates

COMSOL Blog www.comsol.com/blogs

Discussion Forum www.comsol.com/community

Events www.comsol.com/events

COMSOL Video Gallery www.comsol.com/video

Support Knowledge Base www.comsol.com/support/knowledgebase
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U s i n g  t h e  M a t e r i a l  L i b r a r y

This chapter describes the material properties in the Material Library and how to 
use them in your COMSOL Multiphysics® models. It also contains information 
about using functions to define material properties.

In this chapter:

• Working with Materials

• Material Properties

• Other Material Properties Reference

• Using Functions
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Work i n g  w i t h  Ma t e r i a l s

The Material Browser Window

The Material Browser window ( ) contains a number of databases with a broad 
collection of elastic, solid mechanics, electromagnetic, fluid, chemical, thermal, 
piezoelectric, and piezoresistive properties of materials. The number of material 
databases depends on which COMSOL products your license includes. Use the 
Material Browser to find predefined materials and add them to the Model Builder, or 
create a custom material library.

The Material Browser is similar to The Add Material Window but it includes detailed 
property information about each material. From this window you can also create a new 
material library and import a material library. See Adding Materials to a Component 
for information about adding materials to your model’s components (geometries). 
Click Done ( ) to close the Material Browser and add the materials in the Added to 

model list to the model. Click Cancel ( ), press Escape, or click in the main toolbar 
to exit the Material Browser without adding any materials.

Right-click a material library in the Material Browser and choose Reload Selected ( ) 
to clear all cached data for that library and force the COMSOL Multiphysics software 
to reload the content from the file system. This operation is useful, for example, if the 
library is a user-defined library that has been edited since the COMSOL Multiphysics 
session started and needs to be reloaded to display the latest contents.

To open the Material Browser :

• On the Materials toolbar, click Browse Materials.

• Right-click the Materials node ( ), and then select Browse Materials.

• From the Home toolbar, select Windows>Material Browser.

To open the Material Browser :

• On the Model Toolbar, click Browse Materials.

• Right-click the Materials node ( ), and then select Browse Materials.

• Select Windows>Material Browser.
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You can browse all of the available material databases or search for specific materials. 
There is also a  Recent Materials folder where you find the most recently used 
materials. Search a specific material by name (or, for the Material Library product, by 
UNS number or DIN number, which are listed in the Material Browser when 
available).

When browsing the material databases, in particular the Material Library, some 
materials include additional information — UNS number, DIN number, and 
composition.

As in Figure 2-1, the following information is included in the window to the right of 
the material tree. Navigate in the material tree and click a material to display the 
information.

P R O P E R T I E S

While browsing the databases, predefined material properties for the selected material 
are listed in a table in the columns Property, Expression, Unit, and the Property group to 
which the material property belongs. If Property group is empty, the material property 
is a Basic property.

Under Property reference, for the materials in the Material Library product, reference 
information about a material’s properties appears when you click a property above.

I N P U T S

For some materials, predefined function inputs are listed in a table in the columns 
Input, Variable, and Unit. Inputs appear for material properties defined using functions 
that require the input. Typical inputs are temperature and pressure, for temperature- 
and pressure-dependent material properties, respectively.

C R E A T E  A  N E W  M A T E R I A L  L I B R A R Y  O R  I M P O R T  A  M A T E R I A L  L I B R A R Y

Click the New Material Library button ( ) to open the New Material Library dialog 
box. You can also right-click a material and select Add to New Library ( ) to create a 
new material library and add that material to the new library. Go to Creating a New 
Material Library and Adding and Editing Materials in the COMSOL Multiphysics 
Reference Manual.

Material availability is based on the type of COMSOL Multiphysics 
license. For example, if you have the MEMS Module, you have the 
Built-In, Liquids and Gases, MEMS, and Piezoelectric material libraries.
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Click the Import Material Library button ( ) to open the Choose Material Library 

dialog box. Go to Importing a Material Library in the COMSOL Multiphysics 
Reference Manual.

Figure 2-1: The Material Browser details a material’s properties after selection. In this 
example, the properties of Oxygen are listed to the right of the Material Browser folders.
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M A T E R I A L  L I B R A R Y  F O L D E R S  

TABLE 2-1:  MATERIAL LIBRARY FOLDERS

FOLDER

Elements

Iron Alloys

Nickel Alloys

Aluminum Alloys

Copper Alloys

Magnesium Alloys

Titanium Alloys

Simple Oxides

Complex Oxides/Silicates

Carbides

Cermets

Tool Steels

Carbons

Thermal Insulators

Intermetallics

Refractory Metal Alloys

Thermal Barrier Coatings

Nylons and PA/PI (polyamides)

PAI (polyamide-imide)

PPA (polyphthalamides)

Polyethers and Polyesters

PEI (polyetherimide)

PARA (polyarylamide)

Acetal (polyoxymethylene)

PVDF (poly(vinylidene fluoride))

EVA (ethylene-vinyl acetate)

Miscellaneous Polymers

Miscellaneous Polymer Composites

Elastomers

Epoxies
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Minerals, Rocks, and Soils

Woods

PP (polypropylenes)

PET (polyethylene terephthalate)

PBT (polybutylene terephthalate)

ECTFE (polyethylene chlorotrifluoroethylene)

m-PPE and PPE/PA

PAEK and PEEK (polyaryletherketone)

PSU (polysulfone)

PES/PESU (polyethersulfone)

PPSU/PPSF (polyphenysulfone)

Controlled Expansion Alloys

Precious Metal Alloys

Thermocouple Alloys

Semiconductors and Optical Materials

Organics and Hydrocarbons

Other Materials

Solders, Low Melting, and Dental

Cobalt Alloys

Resistance Alloys

Magnetic Alloys

Metal Matrix Composites

Ceramic Matrix Composites

Salts (single component)

Salts (multicomponent)

Salts (binary mixtures)

Salts (ternary mixtures)

Fuel Cell, Battery, and Electro-ceramics

Silicides

Borides

Glasses and Metallic Glasses

TABLE 2-1:  MATERIAL LIBRARY FOLDERS

FOLDER
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The Add Material Window

The Add Material window is similar to The Material Browser Window. It has the same 
material libraries available but does not include the detailed properties about each 
material. The number of material libraries depends on which COMSOL Multiphysics 
products your license includes. This window is a quick way to add materials to models.

To open the Add Material window :

• From the Materials toolbar, click Add Material.

• Right-click the Materials node ( ) and select Add Material from Library.

As in Figure 2-2you can browse all the available material databases or search for specific 
materials. There is also a Recent Materials folder where you find the most recently used 
materials. Search a specific material by name (or, for the Material Library product, by 
UNS number or DIN number).

Nitrides 

Cast Irons

Mold Materials

TABLE 2-1:  MATERIAL LIBRARY FOLDERS

FOLDER
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Figure 2-2: The Add Material window. In this example, the liquid phase of Oxygen is 
selected and can be added to the Material node in the local Component or as a global 
material in the Model Builder.

A D D I N G  M A T E R I A L S  T O  A  C O M P O N E N T

You can add materials to Component nodes using either the Add Material or Material 

Browser windows. In either window, use the Search field to find materials by name, 
UNS number, or DIN number. Or click any of the folders and subfolders to locate and 
add a specific material.  To add a material to the current component, click the Add to 

Component button, right-click the material and choose Add to Component, or, in the 
Add Material window, press Enter. In the Add Material window you can also add a 
material to global Materials list and to the current selection. In the Material Browser 
window, you can also add the material to the global Materials list and to an existing 
user-defined or new material library.
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For example, click the arrow to the left of Elements to expand that folder, and then click 
Oxygen. 

Using the Add Material Window
1 Open the Add Material window (see The Add Material Window).

2 In the Add Material window, select a material by phase (liquid, vapor, gas, or solid) 
and orientation/variation, when available.

3 Click the Add to Global Materials or Add to Component buttons, or right-click the 
material and select the same options from the context menu. If there is more than 
one Component node in the model tree, add the material to the applicable geometry.

- Click the Add to Global Materials button to add it under the global Materials node. 

- Click the Add to Component button to add the material to the active component 
in the Model Builder and then make it an active material in the domains (or other 
geometric entities) where it is selected. You can also select any of the components 
in the model to add it to its Materials node, or select Add to Switch 1, for example, 
to add it under a Switch node for materials under the global Materials node. 
Right-click the Material node to rename it, for example, using the name of the 
material it represents.

Using the Material Browser Window
1 Open the Material Browser window (see The Material Browser Window).

2 In the Material Browser, select options from the Phase and Orientation/variation lists, 
when available (only included for some materials in the Material Library product). 
In this window you can review the material Properties and Input sections. See 
Viewing Material Property Information for information about viewing information 
about, for example, references for a specific material property.

3 Click the Add to Component button ( ) under the list of materials to add the 
selected material to the current model component. Alternatively, click the Add To 
button ( ) to add the material to the global Materials node (choose Global 

Materials), to any available model component, or to an existing or new user-defined 
material library. You can also right-click the selected material node to add that 

In the Add Material window, all the materials are listed with a description 
of the phase and orientation/type next to the primary name (for example, 
Oxygen [liquid], Oxygen [vapor]. This is different in the Material Browser, 
where you select these options from the Phase or Orientation/variation 
lists.
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material to a model component or user-defined material library. Materials that you 
have selected to add to any of the model components appear in the Added to model 
list.

4 Click Done ( ) to add the materials to the model tree in the Model Builder and close 
the Material Browser. If it is the first material in that model component, the material 
in the Model Builder becomes the default material; otherwise, the material is initially 
not used anywhere but becomes the active material in the domains (or other 
geometric entities) that you pick to add to that material’s selection list.

Materials

Use the nodes under Materials ( ) to add predefined or user-defined materials, to 
specify material properties using model inputs, functions, values, and expressions as 
needed, or to create a custom material library. Also see Material Link, Switch for 
Materials, Working with External Materials, and About the Material Databases in the 
COMSOL Multiphysics Reference Manual.

You can right-click the Materials node and select Add Materials from Library to add a 
material using The Add Material Window or select Browse Materials to open The 
Material Browser Window for more thorough information about the available 
materials in the material libraries. Yous can also select Blank Material to add a Material 
node with no predefined material properties.

M A T E R I A L  O V E R V I E W

This section provides an overview of the materials in the Component node and where 
they are used. You can also add materials under Global Definitions. To access such global 
materials in a model component, use a Material Link.

The Material column lists the current materials in the Component using the materials’ 
node labels from the model tree according to the settings defined in Displaying Node 
Names, Tags, and Types in the Model Builder.

The Selection column lists the geometric entities selected for the material (the domains, 
boundaries, or edges where the material is defined).

E R R O R S  R E L A T I N G  T O  T H E  M A T E R I A L  N O D E S

If a material property in a physics interface takes its value from a material and no 
material is defined for the same geometric selection, a stop sign ( ) displays in the 
leftmost column and the Material column contains Entities needing a material. The 
Selection column contains the geometric entities in which a material definition is 
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missing. The Materials node also indicates when there is a material error (see 
Figure 2-3). For example, if some property is deleted but needed in a part of the 
geometry, then the icon indicates where the error is located.

Figure 2-3: An example of a Materials node error.

The Settings Window for Material

The Settings window for Material ( ) summarizes the predefined or user-defined 
material properties for a material. This is where you can add or change material 
properties to fit your model and assign the material to all types of geometric entities: 
domains (most common), boundaries, edges (3D models only), or points. Also see 
Material Link and Switch for Materials.

After adding a material (see The Add Material Window and The Material Browser 
Window), click the Material node (for example, Material 1 or Copper) in the Model 

Builder. The Settings window for Material opens.

A standard Material node in the global component can turn into a layered material by 
adding a Shell property group. After that, it can be linked by a Layered Material Link.
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Figure 2-4: Click the Copper node to open the Settings window for Material for the node. 

G E O M E T R I C  E N T I T Y  S E L E C T I O N

Assign the material to some or all entities on a specific Geometric entity level — Domain, 
Boundary, Edge (3D only), or Point — on the geometry in the Graphics window (the 
geometry in the model).

By default, the first material in the Component is active in all domains (or 
all boundaries or edges if the Component only contains surfaces or 
edges). By assigning other materials to some or all domains, the first 
material is overridden and remains active only in domains where no other 
material, added below it in the Materials branch, is active.

If the Component contains features on different geometric entity levels, 
such as solid mechanics in domains coupled to beams on edges, and the 
features use the same material, you need to add two Material nodes with 
the same material, one defined in the domains, and the other defined on 
the edges.
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O V E R R I D E

This section shows if the material, in some or all parts of the geometry where it is 
active, is overridden by another material added underneath it in the Materials branch, 
or if it overrides another material above it.

The Overridden by list shows the names of the materials that override this material. The 
Selection list in the Geometric Entity section displays (overridden) for the geometric 
entities in which this material is overridden.

The Overrides list shows the names of the materials that this material overrides.

O R I E N T A T I O N  A N D  P O S I T I O N

Select a Coordinate system defining the principal directions of the laminate. Only 
Boundary System coordinate systems can be selected.

Choose a Position — Midplane on boundary, Downside on boundary, Upside on boundary, 
or User defined. This controls the possible offset of the material from the geometrical 
boundary on which the mesh exists (the reference surface). For User defined, enter a 
value for the Relative midplane offset. The value 1 corresponds to Downside on boundary, 
and the value −1 corresponds to Upside on boundary. Values may be outside the range 
−1 to 1, in which case the reference surface is outside the laminate.

The Position setting is only used by physics features where the physical behavior 
depends of the actual location, such as structural shells.

By clicking the Layer Cross Section Preview ( ) button, you get a preview plot of the 
single layer material, including the location of the reference surface. This plot looks 
similar to Figure 2-10, but there is only a single layer.

M A T E R I A L  P R O P E R T I E S

You can add material properties to the material if they are not already included. To do 
so, browse the available material property categories (Basic Properties, Acoustics, and so 

• Physics Exclusive and Contributing Node Types

• Physics and Variables Selection

• Physics Node Status

This section only appears in Material nodes that are single layer material. 
See Single-Layer Materials.
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on), and select a material property or a collection of material properties in one of the 
property groups or material models that appear under the main level of material 
property categories. Right-click the material property or property group and select Add 

to Material, or click the Add to Material button ( ) to add the material property or 
group of properties to the material.

For example, under Acoustics>Viscous Model select Bulk viscosity (muB) and right-click 
to Add to Material or click the Add to Material button ( ). If you add a material model 
like the Viscous Model with more than one property, all of its material properties are 
added to the Material Contents table. In this example, a Viscous model node is added to 
the Model Builder and its associated properties are added to the Material Contents table.

A Note About Adding Basic Material Properties
Material properties can be added to the Basic group or to any User-Defined Property 

Group from two locations — the Settings windows for Material and Property Group.

• When material properties are added from the Basic node’s or a user-defined group 
node’s Settings window for Property Group, they are listed under Output Properties 
and Model Inputs in that Settings window.

• When material properties are added from the Settings window for Material, the 
available material properties are listed under Material Properties and are added to the 
list under Material Contents with the property group listed. The list under Material 

Contents also contains material properties added from a subnode with a Settings 

window for Property Group.

Material Type
The Material type setting decides how materials behave and how material properties are 
interpreted when the mesh is deformed. Select Solid for materials whose properties 
change as functions of material strain, material orientation, and other variables 
evaluated in a material reference configuration (material frame). Select Nonsolid for 
materials whose properties are defined only as functions of the current local state at 

Review the properties listed in the Material Contents table before adding 
new material properties.

To delete a property group, right-click the property group node (in the 
Model Builder) and select Delete ( ). The Basic property group cannot be 
deleted.
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each point in the spatial frame and for which no unique material reference 
configuration can be defined.

Simply put, Solid materials associate material properties with specific pieces of the 
material, and the properties follow the material as it moves around. In particular, a 
solid material may be inherently anisotropic, meaning that its axes rotate together with 
the material. The Nonsolid choice, in contrast, applies typically to liquids and gases 
whose properties are associated with fixed points in space and insensitive to local 
rotation of the material. Such materials are inherently isotropic when studied in 
isolation but can exhibit anisotropy induced by external fields. In practice, this means 
that any anisotropic tensor properties in a nonsolid material must be functions of some 
external vector field.

M A T E R I A L  C O N T E N T S

This section lists all of the material properties that are defined for the material or 
required by the physics in the model. The table lists the Property, Variable, Value, and 
Unit for the material property as well as the Property group to which the material 
property belongs. The Property group corresponds to the subnodes in the Model Builder 
with the same name. If required, edit the values or expression for the property’s Value.

The left column provides visual cues about the status of each property:

• A stop sign ( ) indicates that an entry in the Value column is required. It means 
that the material property is required by a physics feature in the model but is 
undefined. When you enter a value in the Value column, the material property is 
added to its property group.

• A warning sign ( ) indicates that the material property has been added to the 
material but is still undefined. An entry is only required if the material property is to 
be used in the model.

• A green check mark ( ) indicates that the property has a Value and is currently 
being used in the physics of the model.

• A synchronize symbol ( ) indicates that the property is computed and 
synchronized using the given values for other material properties from which it can 
be computed.

• Properties with no indication in the left column are defined but not currently used 
by any physics in the model.

You can change the value for any property that is not synchronized by editing its value 
directly in the Value column, or, for a selected property, click the Edit button ( ) to 
enter a value in the window that opens. If the property can be anisotropic, you can 
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choose to enter the values in one of these forms: Isotropic, Diagonal, Symmetric, or Full. 
The Variable column lists the variable names corresponding to the degree of 
anisotropy. For example, for a symmetric electrical conductivity, it contains {sigma11, 

sigma12, sigma22, sigma13, sigma23, sigma 33}; sigmaij = sigmaji. For an isotropic 
electrical conductivity, it contains sigma_iso; sigmaii = sigma_iso, sigmaij = 0, where 
sigma_iso is the name of the variable for the isotropic electrical conductivity (available 
as, for example, mat1.def.sigma_iso).

A P P E A R A N C E

The settings in this section make it possible to control or change the default appearance 
of a material in the Graphics window when working in the materials or physics parts of 
the model tree. 

The Family list provides quick settings approximating the appearance of a number of 
common materials — Air, Aluminum, Brick, Concrete, Copper, Gold, Iron, Lead, 
Magnesium, Plastic, Steel, Titanium, and Water. Select Custom to make further 
adjustments of the specific settings for colors, texture, reflectance, and so on. The 
default custom settings are inherited from the material selected last from the Family list.

Specular Color, Diffuse Color, and Ambient Color
For each of these properties, click the Color button to assign a Custom specular color or 
select a standard color from the list: Black, Blue, Cyan, Gray, Green, Magenta, Red, White, 
or Yellow.

The combination of Specular color, Diffuse color, and Ambient color gives a 3D object its 
overall color:

• Specular color is the color of the light of a specular reflection (specular reflection is 
the type of reflection that is characteristic of light reflected from a shiny surface). 

• Diffuse color represents the true color of an object; it is perceived as the color of the 
object itself rather than a reflection of the light. The diffuse color gets darker as the 
surface points away from the light (shading). As with Ambient color, if there is a 

In 3D components, the material is rendered including color and texture 
when Scene Light is active. In 2D models and in 3D components, when 
Scene Light is turned off, only a change of color is visible.
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texture, this is multiplied by the colors in the texture, otherwise it is as if it has a 
white texture.

• Ambient color is the color of all the light that surrounds an object; it is the color seen 
when an object is in low light. This color is what the object reflects when illuminated 
by ambient light rather than direct light. Ambient color creates the effect of having 
light hit the object equally from all directions. As with Diffuse color, if there is a 
texture, this is multiplied by the colors in the texture; otherwise, it is as if it has a 
white texture. 

Noise
The Noise check box is selected by default, with the default Normal vector noise scale 
and Normal vector noise frequency taken from the material. Enter other values as 
needed, or click to clear the Noise check box.

• Noise is a texture that disturbs the normals when calculating lighting on the surface. 
This causes the surface to look rough and textured.

• Normal vector noise scale is the power of the noise texture. A high value creates a 
stronger texture of the surface. A value between 0–1 is suitable.

• Normal vector noise frequency is the size of the noise disturbances. A small value 
creates smaller features on the texture. A value between 0–10 is suitable.

Diffuse and Ambient Color Opacity
The default Diffuse and ambient color opacity is 1.

Lighting Model
The default Lighting model — Blinn-Phong or Cook-Torrance — is based on the material. 
Select Simple instead as needed.

The different lighting models provide a set of techniques used to calculate the 
reflection of light from surfaces to create the appropriate shading. For example, a 
specular highlight is the bright spot of light that appears on shiny objects when 
illuminated. Specular highlights are important in 3D computer graphics because they 
provide a strong visual cue for the shape of an object and its location with respect to 
light sources in the scene.

For examples of specular, diffuse, and ambient light, which are related to 
these definitions, see About the 3D View Light Sources and Attributes in 
the COMSOL Multiphysics Reference Manual.
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For Blinn-Phong, the default Specular exponent is 64. The specular exponent determines 
the size of the specular highlight. Typical values for this property range from 1 to 500, 
with normal objects having values in the range 5 to 20. This model is particularly useful 
for representing shiny materials.

For Cook-Torrance, the default Reflectance at normal incidence and Surface roughness are 
taken from the material. The Cook-Torrance lighting model accounts for wavelength 
and color shifting and is a general model for rough surfaces. It is targeted at metals and 
plastics, although it can also represent many other materials.

• Reflectance at normal incidence is the amount of incoming light (0–1) from the 
normal direction (of the surface) that is reflected.

• Surface roughness is a value that describes microreflectance on the surface. Higher 
values create a rougher look of the surface with fewer highlights. A value from 0–1 
is suitable.

Property Groups

The Settings window for Property Group is where output properties and model inputs 
are added, local properties are defined, and expressions for material properties are 
entered in a specific property group such as Basic. The property groups are subnodes 
to a material node. The Settings window for Property Group is displayed when you click 
the property group node (for example, Basic) under the material node (typically with 
the material’s name — Aluminum, for example) in the Model Builder.
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Figure 2-5: An example of a Basic Settings window for Property Group.

A property group under a material creates the following variables:

TABLE 2-2:  VARIABLES GENERATED FROM A PROPERTY GROUP

TYPE VARIABLE NAME SCOPE SELECTION EXAMPLE

Basic 
property

Variable name 
of physical 
quantity

root.material Material selection root.material.
rho

root.<comp>.
<mat>.<group>

Global selection root.comp1.
mat1.def.rho
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O U T P U T  P R O P E R T I E S

The predefined material properties in the property group appear in a table in the 
Output Properties section.

Click the Add button ( ) to add another output property, which you choose from 
one of the available physical quantities in the Physical Quantity dialog box that opens.

If required, edit the expressions in the list’s Expression column. Edit directly in the 
table or in the Expression field underneath the table. You can insert predefined 
expressions by clicking the Insert Expression button ( ) or clicking Ctrl+Space and 
then choosing an expression from the list of predefined expressions. You can also click 
the Edit button ( ), which opens a dialog box for easier specification of orthotropic 
and anisotropic material properties (tensors), when applicable. Select Isotropic, 
Diagonal, Symmetric, or Full when entering the data in the material property’s dialog 
box. In the Expression column, use a syntax with curly braces such as 
{k11, k21, k31, k12, k22, k32, k13, k23, k33} to enter anisotropic material 
properties for a 3-by-3 tensor kij in the order k11, k21, k31, k12, k22, k32, k13, k23, and 
k33. 1, 2, and 3 represent the first, second, and third direction in the active coordinate 
system. In many cases (for example, when entering the elasticity matrix for structural 
mechanics), the matrix must for physical reasons be symmetric. The upper diagonal 
part of the matrix you enter will then be mirrored when forming the actual constitutive 
matrix, and the lower diagonal part is ignored.

The Variable column lists the variable names depending on the type of anisotropy. For 
an isotropic k, k_iso represents its single scalar value.

The Unit and Size columns provide information about the unit and size of the output 
property. The size is 1x1 for a scalar value such as density and 3x3 for a tensor (matrix) 
quantity such as electrical conductivity.

Output 
property

Property name root.material
.group

Material selection root.material.
linzRes.alpha

root.<comp>.
<mat>.<group>

Global selection root.comp1.
mat1.linzRes.
alpha

TABLE 2-2:  VARIABLES GENERATED FROM A PROPERTY GROUP

TYPE VARIABLE NAME SCOPE SELECTION EXAMPLE

It is only possible to add, move, and delete output properties from the 
Basic material properties and with user-defined property groups.
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If desired, you can add information about the property, such as references for its value 
or expression. To do so, click the Edit/Show Property Information button ( ) and 
enter the property information in the dialog box that opens and then click OK. When 
information is available for a property, and information symbol ( ) appears in the 
Info column.

Use the Move up ( ), Move down ( ), and Delete ( ) buttons to organize the 
table as needed.

M O D E L  I N P U T S

The model inputs are physical quantities, such as temperature, that are used as inputs 
in the expressions that define the output properties (for example, to describe a 
temperature-dependent physical quantity). For example, adding Temperature as a 
model input with the variable name T makes it possible to use an expression for the 
heat capacity at constant pressure Cp, such as 300[J/(kg*K)]*T[1/K], which works 
regardless of the name of the actual dependent variable for temperature in the model 
that uses the temperature-dependent material. Without the model input, the 
expression above only works with a temperature variable called T.

Click the Add button ( ) to add another model input, which you choose from one 
of the available physical quantities in the Physical Quantity dialog box that opens.

Use the Move up ( ), Move down ( ), and Delete ( ) buttons to organize the 
table as needed.

L O C A L  P R O P E R T I E S

Here you can enter a user-defined property by entering its variable name in the Name 
column and its corresponding Expression and organizing the table as needed. You can 
also enter a Description, which appears in the Property column in the Material Contents 
section of the parent Material node. In that node, the Name entered here appears in the 
Variable column. These local properties are useful for parameterizing functions that 
describe material properties if they contain inputs other than those that are model 
inputs (such as temperature and pressure). For example, a local property can be a 
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reference value at a certain temperature. Use the Move up ( ), Move down ( ), and 
Delete ( ) buttons to organize the tables as needed.

About Automatic Adding of Property Groups to a Material
Material property groups are automatically added to the material node in the Model 

Builder. You can also add additional predefined property groups or create a User-Defined 

Property Group (on the Materials toolbar, click User-defined Property Group ( ) or 
right-click the Material node). The available properties are collected in property groups 
according to the physical context.

Each property group has a Settings window for Property Group. When a Model Builder 
node is clicked (for example, Basic), the Settings window for Property Group displays 
specific information about that property group. The physical properties for all property 
groups are summarized in a Material Contents table on the Settings window for the 
parent Material node.

Material Link

Add a Material Link node ( ) under a Materials node in a model component to add a 
link to a material that you have added under the global Materials node ( ) and use it 
as a material in that component’s geometry. The Material Link node’s Settings window 
is similar to the Settings window for a material node (see The Settings Window for 
Material), with the exception that there is no Material Properties sections. Instead, it 
includes the following section:

L I N K  S E T T I N G S

From the Material list, select the global material that you want to link to:

• Any global material node, to use that material in the component.

• Any Switch node, if you want to run a material sweep.

• None, to not link to any global material.

Click the Go to Material button ( ) to move to the selected material node. Click the 
Add Material from Library button ( ) to add a global material from the material 

You can use local properties to parameterize a material (for example, to 
create a generic “template” material for a particular symmetry class of 
anisotropic materials). You can then adjust the local property values for 
each instance of the material.
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libraries or a new blank global material. The added material then becomes the one 
selected in the Material list.

Switch for Materials

Use the Switch node ( ) to switch between materials during a solver sweep. You add 
the materials as subnodes under the Switch node. Right-click to add a Blank Material or 
select Add Material from Library to select materials from the libraries in the Add Material 
window. 

The switch for materials acts essentially as a switch statement in a programming 
language; that is, it dynamically selects one of its underlying branches depending on a 
parameter that can be controlled from the solvers, using a Material Sweep study. The 
parameter name is constructed based on the tag of the Switch node, using the special 
namespace matsw. For example, the parameter controlling a Switch node on the global 
level will typically be matsw.sw1, while for a component-level Switch it will be 
matsw.comp1.sw1. 

During a material sweep, the sweep parameter takes consecutive integer values, starting 
from one, indicating which material under the switch that should currently provide 
material properties. You can use the parameter name in conditional expressions to 
control also other aspects of the model. Conversely, it is possible to control a material 
Switch also by manually defining the full switch parameter name in a Parameters node. 
You can then choose the parameter to sweep over in a standard Parametric Sweep node 
or assign it different (integer) values in different parameter Case nodes and sweep using 
a Parameter switch sweep.

The Switch node’s Settings window contains the following sections:

M A T E R I A L  C O N T E N T S

This section lists all of the material properties that are defined for the material or 
required by the physics in the model on domains where the Switch node is the active 
domain material. The table lists the Property, Name, Value, and Unit for the material 
property as well as the Property group to which the material property belongs. The 
Property group corresponds to the subnodes in the Model Builder with the same name. 
If required, edit the values or expression for the property’s Value.
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The list includes properties that are defined by any of the materials under the Switch 
node. The left column provides visual cues about the status of each property:

• A stop sign ( ) indicates that some subnode is missing a required Value. That is, 
the material property is required by a physics feature in the model but is not defined 
for all switch cases.

• A warning sign ( ) indicates that the material property has been added to some 
material subnode but is still undefined.

• A green check mark ( ) indicates that the property has a Value in all subnodes and 
is currently being used in the physics of the model.

A P P E A R A N C E

The settings in this section make it possible to control or change the default appearance 
of the material switch in the Graphics window when working in the materials or physics 
parts of the model tree. See The Settings Window for Material for more information.

Layered Material

In the Layered Material node ( ), you can specify the properties of a multilayer 
laminate. It is used when defining the properties of the following features:

• The Layered Shell interface (requires the Composite Materials Module).

• Layered Linear Elastic Material in the Shell interface (requires the Composite 
Materials Module).

• Thin Layer in the Heat Transfer in Solids interface.

• The Heat Transfer in Shells interface (requires the Heat Transfer Module).

• The Electric Currents, Layered Shell interface (requires the AC/DC Module).

A Layered Material node can be present in two locations in the Model Builder: 

• The most common place is under Global Definitions>Materials. When you reference 
a layered material from a physics interface, you do it indirectly through either a 
Layered Material Link or a Layered Material Link (Subnode) under Materials in the 
current component.

• It can also be a subnode under a Layered Material Stack node in a component.

L A Y E R  D E F I N I T I O N

In this table you specify the properties of each layer.
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Click the Add button ( ) to add another table row. Use the Move up ( ), Move 

down ( ), and Delete ( ) buttons to organize the table as needed. To completely 
reset the table to its default state, you can use the Reset to Default button ( ).

Conceptually, the layers are ordered from bottom to top of the laminate. Enter the 
following data in the table:

Layer
Here you can assign a name to the layer for future reference. The default is a sequential 
numbering: Layer 1, Layer 2, and so on.

Material
Select any available material. If the Layered Material node is located under Global 

Definitions, the list contains only global materials. If the Layered Material node is used 
as a subnode to a Layered Material Stack, also materials defined under Materials in the 
component are available.

When you have a certain row in the table selected, you can access three shortcuts:

• Click the Blank Material ( ) button to add a new blank material under global 
materials. The material is referenced in current row of the Material column.

• Click the Add Material from Library ( ) button to add a new material under global 
materials from Material Libraries. The material is referenced in current row of the 
Material column.

• Click the Go to Material ( ) button to jump to the definition of the material 
selected on the current row.

When you add a new row to the table, the same material as on the previous row is 
selected. This means that if you have many, not adjacent, layers with the same material, 
it is more efficient to initially add all layers with that same material. Then you can go 
back and change the material for some layers. Alternatively, you can reorder the layers 
using the Move up ( ) and Move down ( ) buttons.

Rotation
If the material in the layer is orthotropic or anisotropic, enter the angle in degrees 
(positive counterclockwise) from the first principal axis of the laminate to the first 
principal axis of the layer. Even for an isotropic material, the orientation can matter for 
result presentation, since it affects the interpretation of for example stress tensor 
components.
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Thickness
Enter the thickness of the layer (default unit: m). The thickness can be numeric value 
or a scalar parameter.

Mesh elements
In the physics interfaces, the layered materials are handled through the concept of a 
virtual extra dimension. For a layered material defined on a boundary, you can think 
of that as an extra coordinate in the normal direction. Enter the number of elements 
that you want in the extra dimension for the layer.

I N T E R F A C E  P R O P E R T Y

In some physics features, not only the layers themselves but also the interfaces between 
them are important. In such a case, you can assign materials to the interfaces in this 
table. The number of interfaces is one more than the number of layers because the free 
top and bottom surfaces of the laminate are also considered as interfaces.

In most cases, you do not need to enter anything in this section.

Interface
This is the interface name, for future reference. As a default, the interface name is 
constructed from the names of the two adjacent layers. For the top and bottom 
interfaces, the labels “up” and “down” are used for the two exterior sides.

You can rename the interfaces. This is, however, seldom needed.

Position
This column shows the location of the interface. The distance is counted from the 
bottom of the laminate. The column is for information only, and cannot be modified.

Material
Select the material of the interface. You only need to assign materials to the interfaces 
that are explicitly referenced by physics features. The default is to take the material 
From layer. The interface material properties are then computed from the adjacent 
layers’ material properties.
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Figure 2-6 shows an example of the settings for a layered material. The layer names 
have been entered manually, whereas the interfaces have retained their default names.

Figure 2-6: Settings for a material with three layers.

You can save the laminate definition to a text file by clicking the Save Layers to 

File ( ) button. For the example above, the text file has the following contents:

Bottom mat1 0.0 1.2E-4 2
"Middle layer" mat2 45 2.3E-4 2
Top mat1 60 3.4E-4 2
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To load a text file on this format, click the Load Layers from File ( ) button. For 
complex laminates, it may be easier to start by creating the text file representation in a 
text editor, than to enter the data in the GUI.

You have two options for visualizing the laminate defined in the Layered Material node. 
To see the thickness of each layer, click the Layer Cross Section Preview ( ) button. 
This will give a plot like the one shown in Figure 2-7.

Figure 2-7: The layer cross section plot for a material with three layers.

To visualize the layer orientations, click the Layer Stack Preview ( ) button. In 
Figure 2-8, an example of such a plot is shown. The x-axis corresponds to the principal 
laminate direction, and the stripes indicate the principal direction of each layer.

When loading a file, the second column containing the material tag is 
ignored. The reason is that there is no way to ascertain that a material tag 
like ‘mat2’ would point to the same material in another context. You can 
even load a file where that column is absent.
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Figure 2-8: The layer stack preview plot for a material with three layers.

P R E V I E W  P L O T  S E T T I N G S

In this section, you can fine-tune the display in the preview plots.

In the Distance between the orientation lines text field, you can enter a value for the 
spacing of the stripes showing the orientation of the principal orientation of the layer. 
The layer itself is always drawn as a square with the unity side length. If you deselect 
the corresponding check box, no orientation lines are drawn.

The value of the Thickness-to-width ratio is used by both types of preview plots.

• In a layer stack preview plot, it controls the height of the stack in the z direction. 
For laminates with many layers, you may need to increase this value.

• In the layer cross section preview plot, it controls the height in the y direction. The 
width is always unity.

Clear the Shows labels in cross section plot check box to remove the text labels showing 
layer names and materials.



40 |  C H A P T E R  2 :  U S I N G  T H E  M A T E R I A L  L I B R A R Y

Layered Material Link

The Layered Material Link node ( ) provides a bridge from a Layered Material, 
located under Global Definitions, to a physics feature residing in a component. A physics 
feature designed to work with layered materials cannot directly reference a Layered 

Material. The Layered Material Link node is located in the Layers submenu under a 
Materials node.

L A Y E R E D  M A T E R I A L  S E T T I N G S

Select a layered material from the Material list. You can also select a Switch for 
Materials.

By clicking the Go to Material ( ) button, you can jump to the settings for the 
selected material.

Click the Add Layered Material button ( ) to add another Layered Material or a Switch. 
The added material then becomes the one selected in the Material list.

From the Transform list, choose one of the following options:

• None (the default), for no transformation.

• Symmetric or Antisymmetric, to create a symmetric or antisymmetric layered material 
when the information of layers of one side of the midplane is supplied. Choose 
which side to mirror in from the Mirror in list: Upside (the default) or Downside. 
Upside means that the symmetry layers are on the top of the original layers. The 
symmetry line is the top-side boundary. Downside means that the symmetry layers 
are on the bottom of the original layers. The symmetry line is the bottom-side 
boundary. Select the Merge middle layers check box to merge the two middle layers 
into one to create an odd symmetric layer.

• Repeated, to create a number of repeating stacks, which you enter in the Number of 

repeats field (default: 1).

Select the Scale check box to scale the layered material’s thickness with a factor 
(default: 1).The scale can be a numerical value, a parameter, or an expression. Such an 
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expression can, for example, be a function of the coordinates so that a surface with 
variable thickness can be described.

If you have defined a layer with a scaling factor, it appears in the preview window with 
a darker color than a nonscaled layer.

The labels of the newly created layers include a suffix to distinguish them from the 
original layers:

• (sym) for the symmetric layers.

• (asym) for the antisymmetric layers.

• (repX) for the repeated layers (number X).

Click the Layer Cross Section Preview button (  to plot a preview of the layer cross 
section including the transformation (see the following plot for an example).

Figure 2-9: A repeat laminated stacks with 2 times repeated layers.

Click the Layer Stack Preview button ( ) to get a preview of the stack with the 
transformation.

If a single layer in a laminate has a variable thickness, you can define that 
layer in either a separate Layered Material or in a Single Layer Material.

• When using a Layered Material, apply the scaling expression in a Layered 

Material Link, and then use a Layered Material Stack to build the 
complete laminate.

• When using a Single Layer Material with an expression for the thickness, 
use a Layered Material Stack to build the complete laminate.

The preview is not shown in the base geometry space, so it will not show 
any geometrical dependency.
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O R I E N T A T I O N  A N D  P O S I T I O N

Select a Coordinate system defining the principal directions of the laminate. The 
orientation of each layer, given in the Layered Material node, is a rotation from the first 
coordinate axis of this coordinate system. Only Boundary System coordinate systems 
can be selected.

Choose a Position — Midplane on boundary, Down side on boundary, Up side on boundary, 
or User defined. This controls the possible offset of the layered material from the 
geometrical boundary on which the mesh exists (the reference surface). For User 

defined, enter a value for the Relative midplane offset. The value 1 corresponds to Down 

side on boundary, and the value −1 corresponds to Up side on boundary. Values may be 
outside the range −1 to 1, in which case the reference surface is outside the laminate.

The Position setting is only used by physics features where the physical behavior 
depends of the actual location, such as structural shells.

By clicking the Layer Cross Section Preview ( ) button, you get a preview plot of the 
layered material, including the location of the reference surface (Figure 2-10). The 
height of the laminate in the plot is controlled by the value of the Thickness-to-width 

ratio specified in the Preview Plot Settings for the selected layered material.
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Figure 2-10: Layer cross section preview plot with relative offset set to 0.5.

N O N L A Y E R E D  M A T E R I A L  S E T T I N G S

In some cases, a single standard material definition is needed on the same boundary as 
a layered material. This can, for example, be the case if two different physics interfaces 
are active on the same boundary, but only one of them supports a layered material 
definition. You can select any nonlayered material from the Material list. The default 
settings is Same as layered material, which means that the nonlayered material 
properties are computed as an average value of the layer’s material properties. This 
selection is completely analogous to using a Material Link.

By clicking the Go to Material ( ) button, you can jump to the settings for the 
selected material.

You cannot use an ordinary Material or Material Link with the same 
selection as the Layered Material Link. These nodes override each other.



44 |  C H A P T E R  2 :  U S I N G  T H E  M A T E R I A L  L I B R A R Y

Click the Add Material from Library button ( ) to add a global material from the 
material libraries or a new blank global material. The added material then becomes the 
one selected in the Material list.

P R E V I E W  P L O T  S E T T I N G S

In this section, you can fine-tune the display in the preview plot.

The value of the Thickness-to-width ratio controls the height in the y direction. The 
width is always unity.

Deselect the Shows labels in cross-section plot check box to remove the text labels 
showing layer names and materials.

M A T E R I A L  C O N T E N T S

See the documentation for Material Contents for the Material node.

The Value column will usually contain the string Layer, indicating that the actual value 
is layer dependent.

A P P E A R A N C E

See the documentation for Appearance for the Material node.

Layered Material Stack

In the Layered Material Stack node ( ), you can compose a new layered material by 
stacking other layered materials (including Material nodes that define single-layer 
materials) on top of each other. There are three main reasons why you may want to do 
this:

• The layup is repetitive, say with the same four layers repeated five times. Rather than 
defining twenty layers in a Layered Material node, you define four, and then add this 
definition five times in a Layered Material Stack.

• There are layer drop-offs, that is some layers are not present everywhere in the 
structure. Then, it is efficient to create only subsets of the laminate in Layered 

Material nodes, and use a number of Layered Material Stack nodes to combine them 
into different configurations.

• Two Layered Material Stack nodes can have parts of their definitions linked to the 
same Layered Material node. When a transition through a continuity feature is used, 
the corresponding layers in two laminates defined as stacks can be connected 
automatically.
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The Layered Material Stack node is located in the Layers submenu under a Materials 
node. To compose the stack, you add subnodes to the Layered Material Stack. These 
subnodes can be either a Layered Material or a Layered Material Link (Subnode). You 
can add any number of subnodes, and mix the two types. The order of the subnodes 
determines the ordering of the layers in the final laminate.

L A Y E R E D  M A T E R I A L  S E T T I N G S

From the Transform list, choose one of the following options:

• None (the default), for no transformation.

• Symmetric or Antisymmetric, to create a symmetric or antisymmetric layered material 
when the information of layers of one side of the midplane is supplied. Choose 
which side to mirror in from the Mirror in list: Upside (the default) or Downside. 
Upside means that the symmetry layers are on the top of the original layers. The 
symmetry line is the top-side boundary. Downside means that the symmetry layers 
are on the bottom of the original layers. The symmetry line is the bottom-side 
boundary. Select the Merge middle layers check box to merge the two middle layers 
into one to create an odd symmetric layer.

• Repeated, to create a number of repeating stacks, which you enter in the Number of 

repeats field (default: 1).

Select the Scale check box to scale the layered material’s thickness with a factor (default: 
1). If you have defined a layer with a scaling factor, it appears in the preview window 
with a darker color than a nonscaled layer.

The labels of the newly created layers include a suffix to distinguish them from the 
original layers:

• (sym) for the symmetric layers.

• (asym) for the antisymmetric layers.

• (repX) for the repeated layers (number X).

The interface between the two Layered Material Stack nodes takes the 
interface material from the first Layered Material Stack node and ignores 
the interface material of the second Layered Material Stack node.

The preview is not shown in the base geometry space, so it will not show 
any geometrical dependency.
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Click the Layer Cross Section Preview button (  to plot a preview of the layer cross 
section including the transformation. Click the Layer Stack Preview button ( ) to get 
a preview of the stack with the transformation.

O R I E N T A T I O N  A N D  P O S I T I O N

Select a Coordinate system defining the principal directions of the laminate. The 
orientation of each layer, given in the Layered Material node, is a rotation from the first 
coordinate axis of this coordinate system. Only Boundary System coordinate systems 
can be selected.

Choose a Position — Midplane on boundary, Down side on boundary, Up side on boundary, 
or User defined. This controls the possible offset of the layered material from the 
geometrical boundary on which the mesh exists (the reference surface). For User 

defined, enter a value for the Relative midplane offset. The value 1 corresponds to Down 

side on boundary, and the value −1 corresponds to Up side on boundary. Values may be 
outside the range −1 to 1, in which case the reference surface is outside the laminate.

The Position setting is only used by physics features where the physical behavior 
depends of the actual location, such as structural shells.

By clicking the Layer Cross Section Preview ( ) button, you get a preview plot of the 
stacked layered material, including the location of the reference surface. In 
Figure 2-11, a laminate composed of three stacked layered materials, each consisting 
of three layers is shown. Note that there is a slight indentation, used for emphasizing 
the transition from one part of the stack to the next.

A combination of transformations can be made by defining the 
transformations for both the Layered Material Stack node and a Layered 

Material Link subnode.
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Figure 2-11: Layer cross section preview plot with relative offset set to Down side on 
boundary.

N O N L A Y E R E D  M A T E R I A L  S E T T I N G S

In some cases, a single standard material definition is needed on the same boundary as 
a layered material. This can for example be the case if two different physics interfaces 
are active on the same boundary, but only one of them supports a layered material 
definition. You can select any nonlayered material from the Material list. The default 
settings is Same as layered material, which means that the nonlayered material 
properties are computed as an average value of the layer’s material properties. This 
selection is completely analogous to using a Material Link.

By clicking the Go to Material ( ) button, you can jump to the settings for the 
selected material.

You cannot use an ordinary Material or Material Link with the same 
selection as the Layered Material Stack. These nodes override each other.



48 |  C H A P T E R  2 :  U S I N G  T H E  M A T E R I A L  L I B R A R Y

Click the Add Material from Library button ( ) to add a global material from the 
material libraries or a new blank global material. The added material then becomes the 
one selected in the Material list.

P R E V I E W  P L O T  S E T T I N G S

In this section, you can fine-tune the display in the preview plot.

The value of the Thickness-to-width ratio controls the height in the y direction. The 
width is always unity.

Deselect the Shows labels in cross-section plot check box to remove the text labels 
showing layer names and materials.

M A T E R I A L  C O N T E N T S

See the documentation for Material Contents for the Material node.

The Value column will usually contain the string Layer, indicating that the actual value 
is layer dependent.

A P P E A R A N C E

See the documentation for Appearance for the Material node.

Layered Material Link (Subnode)

The Layered Material Link subnode ( ) is used for referencing a Layered Material 
from a Layered Material Stack node. You can add any number of Layered Material Link 
subnodes under a Layered Material Stack node.

L I N K  S E T T I N G S

Select a layered material from the Material list.

By clicking the Go to Material ( ) button you can jump to the settings for the selected 
material.

Click the Add Layered Material button ( ) to add another Layered Material or a Switch. 
The added material then becomes the one selected in the Material list.

From the Transform list, choose one of the following options:

• None (the default), for no transform.

• Symmetric or Antisymmetric, to create a symmetric or antisymmetric layered material 
when the information of layers of one side of the midplane is supplied. Choose 



W O R K I N G  W I T H  M A T E R I A L S  |  49

which side to mirror in from the Mirror in list: Upside (the default) or Downside. 
Upside means that the symmetry layers are on the top of the original layers. The 
symmetry line is the top-side boundary. Downside means that the symmetry layers 
are on the bottom of the original layers. The symmetry line is the bottom-side 
boundary. Select the Merge middle layers check box to merge the two middle layers 
into one to create an odd symmetric layer.

• Repeated, to create a number of repeating stacks, which you enter in the Number of 

repeats field (default: 1).

Select the Scale check box to scale the layered material’s thickness with a factor 
(default: 1). The scale can be a numerical value, a parameter, or an expression. Such an 
expression can, for example, be a function of the coordinates so that a surface with 
variable thickness can be described.

If you have defined a layer with a scaling factor, it appears in the preview window with 
a darker color than a nonscaled layer.

The labels of the newly created layers include a suffix to distinguish them from the 
original layers:

• (sym) for the symmetric layers.

• (asym) for the antisymmetric layers.

• (repX) for the repeated layers (number X).

Click the Layer Cross Section Preview button (  to plot a preview of the layer cross 
section including the transform. Click the Layer Stack Preview button ( ) to get a 
preview of the stack with the transform.

If a single layer in a laminate has a variable thickness, you can define that 
layer in either a separate Layered Material or in a Single Layer Material.

• When using a Layered Material, apply the scaling expression in a Layered 

Material Link, and then use a Layered Material Stack to build the 
complete laminate.

• When using a Single Layer Material with an expression for the thickness, 
use a Layered Material Stack to build the complete laminate.

The preview is not shown in the base geometry space, so it will not show 
any geometrical dependency.
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Single-Layer Materials

To add a single-layer material, choose Single Layer Material ( ) from the global 
Materials node’s context menu or the Layers submenu on the context menu of a 
Materials node in a component. Then, a Material node is created with some additional 
settings (see The Settings Window for Material) and a Shell property group (see 
Geometric Properties (Shell)) with a default thickness of 10−4 m. You can also switch 
an Material node into a single-layer material by adding a Shell property group and 
define a thickness, and it can also turn into a single-layer material when you specify a 
value for the requested thickness in the Material Contents table, which appears when a 
layered shell feature requests the material properties from a standard material. The 
thickness for a single-layer material can be defined as a numerical value, a parameter, 
or an expression. Such an expression can, for example, be a function of the coordinates 
so that a surface with variable thickness can be described.

Single-layer materials provide a quick way to define data for a nonlayered material to 
be used in physics feature designed for layered materials. Using a single-layer material 
is equivalent to defining a Layered Material with only one layer and then referencing it 
through a Layered Material Link. A single-layer material can be linked by a Layered 
Material Link, and it can also e a stack member of a Layered Material Stackl or a switch 
member of a Switch for Materials.

If a single layer in a laminate has a variable thickness, you can define that 
layer in either a separate Layered Material or in a Single Layer Material.

• When using a Layered Material, apply the scaling expression in a Layered 

Material Link, and then use a Layered Material Stack to build the 
complete laminate.

• When using a Single Layer Material with an expression for the thickness, 
use a Layered Material Stack to build the complete laminate.
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Ma t e r i a l  P r o p e r t i e s

The materials included in the Material Library are defined by unique material 
properties, each available as a function of temperature or another appropriate 
argument. Table 2-4 lists most of the material properties in the Material Library.

Viewing Material Property Information

For all properties contained in the Material Library, you can view applicable literature 
references, notes, and reference temperatures in the Material Browser’s Property 

reference section.

1 Open the Material Browser.

2 Under Material Library, click to select a material. For example, Nitrogen. The 
information about this material displays on the right-hand side of the window.

3 Under Properties in the table, click a Property to see its references in the Property 

reference section. See Figure 2-12.

It is important to check the validity of the material property function 
under the conditions that you are interested in investigating. See 
Checking the Validity of Properties in the Material Library.

Individual material properties contained in the Material Library are based 
on the Material Property Database (MPDB) from JAHM Software, Inc. 
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Figure 2-12: An example of where you can find the property reference information for a 
material. In this example, Density has this information available in the Property reference 
section. You can hover over the section and drag to expand it if required.

Functions Default Values in the Material Library

The material property expressions stored in the Material Library contain calls to the 
corresponding material property functions using input variables (arguments) as in 
Table 2-3. The default variable name can be changed in the property expressions to 
match actual variable names in a model. When a material property is used by a physics 
feature set to retrieve the property From material this is not necessary. In that case, the 
actual variable are retrieved from the Model Inputs section of the same feature and 
automatically substituted into the material property expression.

If you, on the other hand, want to access material properties from a material explicitly, 
you need to make sure that the function argument variables used in the property 
expressions exist and can be evaluated in the model. For example, if the variable T2 is 
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used for temperature, change the argument of the property functions from T to T2 in 
the expressions.

Available Material Library Material Properties

The following table lists the material properties in the Material Library:

The argument does not have to be a variable defined by the model (such 
as dependent variables) — it can also be a user-defined constant or 
variable. In general, COMSOL Multiphysics tries to find the best match 
for evaluating function arguments when material properties are accessed 
explicitly.

TABLE 2-3:  DEFAULT FUNCTION ARGUMENTS IN MATERIAL PROPERTY EXPRESSIONS

ARGUMENT DEFAULT VARIABLE UNIT

Temperature T K

Time t h

Effective plastic strain epe -

Number of cycles n -

Norm of H field normH_emnc A/m

Norm of B field normB_emqa T

TABLE 2-4:  MATERIAL LIBRARY: AVAILABLE MATERIAL PROPERTIES

PROPERTY SHORT NAME ARGUMENT SI UNIT

Coefficient of thermal expansion alpha Temperature 1/K

Creep strength CS Time Pa

Density rho Temperature kg/m3

Dynamic viscosity eta Temperature Pa·s

Electrical conductivity sigma Temperature S/m

Resistivity res Temperature ohm·m

Elongation elong Temperature -

Fatigue E-N curve FEN Number of cycles Pa

Fatigue S-N curve FSN Number of cycles Pa

Heat capacity C Temperature J/(kg·K)

Bulk modulus K Temperature Pa

Shear modulus G Temperature Pa
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Checking the Validity of Properties in the Material Library

The following section lists points to consider about the definition, error estimate, and 
conditions for some of the Material Library properties listed in Table 2-4.

Instantaneous coefficient of thermal 
expansion

CTE Temperature 1/K

Linear expansion dL Temperature -

Molar heat capacity HC Temperature J/(mol·K)

Nonlinear magnetic flux density, norm normB Norm of H field T

Nonlinear magnetic field, norm normH Norm of B field A/m

Normal total emissivity nemiss Temperature -

Poisson’s ratio nu Temperature -

Relative permeability mur Norm of H field -

Stress rupture SR Time Pa

Surface emissivity epsilon Temperature -

Tensile strength Syt Temperature Pa

Thermal conductivity k Temperature W/(m·K)

Thermal diffusivity TD Temperature m2/s

True stress–true strain curve in tension Syfunc Strain Pa

True stress–true strain curve in 
compression

Syfunccomp Strain Pa

Vapor pressure VP Temperature Pa

Yield strength level Sys Temperature Pa

Young’s modulus E Temperature Pa

TABLE 2-4:  MATERIAL LIBRARY: AVAILABLE MATERIAL PROPERTIES

PROPERTY SHORT NAME ARGUMENT SI UNIT

The property functions listed below have a literature reference where you 
can find more details about the conditions and validity range for that 
specific property. 
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C O E F F I C I E N T  O F  T H E R M A L  E X P A N S I O N

• The coefficient is defined as (ΔL/L)T/(T − Tref) and in most cases, it is calculated 
from the ΔL/L values.

• The error is expected to be in the range of 10–15%, but it might be higher near 
room temperature due to the small value of T − Tref.

E L A S T I C  A N D  I N I T I A L  S H E A R  M O D U L U S

• The data accuracy is approximately 5–10%.

• For solder alloys the literature reports a wide spread of values. Data from several 
sources (when available) are evaluated, and representative values are given; the error 
is estimated to be 10–25%.

• For some polymers the flexural modulus is used as the elastic modulus, and it is 
typically within 10% of the elastic modulus.

• Typically, values measured with a strain gauge are approximately 10% lower than 
those measured with a dynamic technique.

• Values measured by a dynamic technique are preferred over those measured by 
strain gauge techniques.

• For cubic materials where the elastic and shear modulus are calculated from the 
elastic constants (C11, C12, and C44), the Material Library uses the average of the 
Reuss and Voigt equations (see R.F.S. Hearmon, Advances in Physics, vol. 5, 1956, 
p. 232).

• For isotropic solids (glasses), it uses methods from L.D. Landau and E.M. Lifshitz, 
Theory of Elasticity, Addison-Wesley, New York, 1966.

P O I S S O N ' S  R A T I O  A N D  I N I T I A L  B U L K  M O D U L U S

• Calculated from the elastic modulus and the shear modulus using standard 
relationships, and in this sense they are self-consistent and accurate.

• Data accuracy is approximately 10–20%. Because these are derived quantities the 
error can be significantly higher.

• The curves for these properties often show improbable shapes that are most likely 
due to their derived nature and are not believed to be real. If the elastic and shear 
modulus were determined in a self-consistent manner, the curves would likely be 
much better behaved. However, all of the data are presented “as is” from the 
original references and are self-consistent within the Material Library.
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T H E R M A L  C O N D U C T I V I T Y

• Can be very sensitive to impurities, heat treatment, and mechanical worked state, 
especially at very low temperatures.

• The sensitivity is somewhat decreased above room temperature and decreases as the 
amount of alloying increases. Compare 4340-QT (quenched and tempered) and 
4340-NT (annealed).

T H E R M A L  D I F F U S I V I T Y

• For metals this property can be very sensitive to impurities, heat treatment, and 
mechanical worked state, especially at very low temperatures.

• This sensitivity is somewhat decreased above room temperature and decreases as the 
amount of alloying increases. To see an example of this, compare the data for 
elemental (high purity) Fe and Armco iron (commercial purity).

E L E C T R I C  R E S I S T I V I T Y

This property is very sensitive to impurities, heat treatment, and mechanical worked 
state, especially at very low temperatures.

E L E C T R I C A L  C O N D U C T I V I T Y

This property is very sensitive to impurities, heat treatment, and mechanical worked 
state, especially at very low temperatures.

S U R F A C E  E M I S S I V I T Y  ( εT)

This property is the measured emissivity over all wavelengths and 2π radians. This is 
the emissivity used in the Stefan-Boltzmann law.

N O R M A L  T O T A L  E M I S S I V I T Y  ( εT,n)

• The measured emissivity is over all wavelengths at a direction normal to the surface. 
This is the most commonly reported value. 

• For polished metal, this assumption is valid: εT/εT,n = 1.15–1.20.

• Both emissivities are sensitive to the surface condition (roughness and oxide 
thickness).

D E N S I T Y  ( ρ)

• The density for solids is calculated from the room-temperature density and the 
linear expansion coefficient and is given by ρ/(1 + ΔL/L)3. 

• The data for oxides, carbides, and nitrides depend on the material’s porosity.

• For gases the ideal gas law is used.
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T E N S I L E  S T R E N G T H ,  Y I E L D  S T R E N G T H  L E V E L ,  A N D  E L O N G A T I O N  

• The variation with temperature is usually not smooth. Many of these materials are 
precipitation hardening alloys, and the temperature affects the aging processes in 
different ways at different temperatures.

• Unless otherwise stated, the data are for “short” times at the indicated temperatures 
and not for the equilibrium structure. 

• These properties are very sensitive to the details of the processing and heat 
treatments. Comparison of data from different suppliers indicate that the spread in 
the published values is approximately 20% for materials with similar processing. The 
spread in the elongation data can be as high as 50–100%.

F A T I G U E  S - N  C U R V E

• Fatigue data is given as the maximum stress, σmax, as function of the number of 
cycles. The stress amplitude, maximum stress, and minimum stress are related 
through the stress ratio, R.

• The maximum stress, σmax, is given together with the stress ratio for all fatigue data. 
Then calculate the stress amplitude as:

C R E E P  S T R E N G T H  A N D  S T R E S S - R U P T U R E  C U R V E S

This property is very sensitive to the test atmosphere as well as the microstructure and 
heat treatment of the material.

P O L Y M E R S  A N D  P O L Y M E R - B A S E D  C O M P O S I T E S

Properties of polymers and polymer-based composites are sensitive to moisture and 
processing conditions, and they can show time-dependence at higher temperatures. 

Most of the data for tensile strength, yield strength level, and elongation 
is from supplier product brochures. When using this data, remember it is 
only representative of the actual material properties. 

σa
σmax σmin–( )

2
------------------------------------= R

σmax
σmin
-------------=
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R
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The errors/uncertainties can be large compared to those of other materials. Keep these 
aspects in mind when using the properties of these materials.

G E N E R A L

The magnitude of the errors reported by authors for a given property is usually smaller 
by a factor of 2–3 than the error between different sources for the same data. This is 
especially true for materials such as ceramics.
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O th e r  Ma t e r i a l  P r o p e r t i e s  R e f e r e n c e

In addition to the specific properties included with the Material Library, the other 
material databases also contain predefined variables for various material properties that 
can be used when creating a model.

The material properties for the predefined materials are accessible from most physics 
interfaces. Using this information, either create a material property group or define a 
completely new material.

In the Basic>Property Group window, you can add Output Properties under the 
Quantities subsection. You can also add Model Inputs to, for example, create a 
temperature-dependent material property.

About Model Inputs

Model inputs is a special type of parameter in physics features or physics properties 
where you can choose from a list of announced variables (typically field quantities such 
as temperature, concentration, or electric field, where vector fields have three 
components). Model inputs can also be used as an input to a Property Group under a 
material to represent, for example, a temperature-dependent material property. If the 
property group specifies that it supports one or more model inputs, any physics feature 
that uses the group’s material will display those model input lists in the Model Inputs 
section of the physics node’s Settings window. Any physical quantity in COMSOL 
Multiphysics can be used as a model input.

Model inputs are always available as default model inputs. See Default Model Inputs 
in the COMSOL Multiphysics Reference Manual.
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All physical quantities that can act as model inputs declare and define common 
variables that are always available (for example, minput.T for the temperature T).

About the Output Material Properties

This section describes all available property groups and the material properties that 
they contain. These material properties can be added to models from two Settings 
windows: the Material node’s window and its subnodes’ Property Group windows.

The Basic group contains over 25 basic properties for use with all materials.

To define the absolute pressure for heat transfer, see the settings for the 
Fluid node in the COMSOL Multiphysics Reference Manual.

To define the absolute pressure for a Fluid Flow interface, see the settings 
for the Fluid Properties node (described for the Laminar Flow interface 
in the COMSOL Multiphysics Reference Manual).

If you have a license for a Nonisothermal Flow interface, see that 
documentation for further information.

Model Inputs and Multiphysics Couplings in the COMSOL Multiphysics 
Reference Manual

Some of these material groups are only used by physics interfaces in the 
add-on modules and detailed information is in the applicable 
documentation.

Materials in the COMSOL Multiphysics Reference Manual
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B A S I C  M A T E R I A L  P R O P E R T I E S

These common material properties belong to the Basic property group.

• When this information is accessed from the Basic>Property Group window, it is listed 
under Quantities>Output Properties and Variable is listed in the table.

• When this information is accessed from the Material window, it is listed under 
Material Properties>Basic Properties and Name is listed in the table under 
Material Contents. 

TABLE 2-5:  BASIC MATERIAL PROPERTIES

PROPERTY NAME/VARIABLE SI UNIT

Absorption Coefficient kappaR 1/m

Activation Energy dE J/mol

Bulk Viscosity muB Pa·s

Characteristic Acoustic Impedance Z Pa·s/m

Coefficient of Hygroscopic Swelling beta_h_iso, beta_hii m3/kg

Coefficient of Thermal Expansion alpha 1/K

Compressibility of Fluid chif 1/Pa

Density rho kg/m3

Diffusion Coefficient D m2/s

Dynamic Viscosity mu Pa·s

Electrical Conductivity sigma S/m

Electron Mobility mue m2/(Vs)

Extinction Coefficient betaR 1/m

Frequency Factor A 1/s

Heat Capacity at Constant Pressure Cp J/(kg·K)

Isotropic Structural Loss Factor eta s 1

Mass Flux Mf kg/(m2·s)

Mean Molar Mass Mn kg/mol

Permeability kappa m2

Poisson’s Ratio nu 1

Porosity epsilon 1

Ratio of Specific Heats gamma 1

Relative Permeability mur 1

Relative Permittivity epsilonr 1
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Resistivity res Ω·m

Scattering Coefficient sigmaS 1/m

Seebeck Coefficient S V/K

Shifted Magnetic Field shiftedH A/m

Speed of Sound cp m/s

Storage S 1/Pa

Surface Emissivity epsilon rad 1

Thermal Conductivity k W/(m·K)

Thermal Conductivity Supplement b 1

Vapor Permeability delta_p s

Vapor Resistance Factor mu_vrf 1

Water Content w_c kg/m3

Young’s Modulus E Pa

TABLE 2-5:  BASIC MATERIAL PROPERTIES

PROPERTY NAME/VARIABLE SI UNIT

The coefficient of thermal expansion (CTE) and the resistivity 
temperature coefficient have the SI unit 1/K. COMSOL Multiphysics 

translates this into the Fahrenheit temperature unit using an offset. This 
translation means that you do not get the expected results.

Use caution when a model uses the coefficient of thermal expansion or the 
resistivity temperature coefficient and the unit system’s temperature is not 
kelvin.
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The rest of the material properties are grouped by application area:

Acoustics Material Properties

Under Acoustics, you find the following acoustic material models with their associated 
material properties: a Poroacoustics Model, a Thermoviscous Acoustics Model, and a 
Viscous Model.

These material property groups (including their associated physical properties) can be 
added to models from the Material window. These property groups are used by the 
Acoustics Module.

• Acoustics Material Properties

• Electrochemistry Material 
Properties

• Electromagnetic Models

• Equilibrium Discharge

• Gas Models

• Geometric Properties (Shell)

• Magnetostrictive Models

• Piezoelectric Models

• Piezoresistive Models

• Semiconductors Material Properties

• Solid Mechanics Material Properties

• Solid Mechanics Material Properties: 
Nonlinear Structural Materials 
Module

• Solid Mechanics Material Properties: 
Fatigue Module

• Solid Mechanics Material Properties: 
Geomechanics Material Model

TABLE 2-6:  ACOUSTICS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

NONLINEAR MODEL

Parameter of nonlinearity BA 1

POROACOUSTICS MODEL

Flow resistivity Rf Pa·s/m2

Thermal characteristic length Lth m

Viscous characteristic length Lv m

Tortuosity factor tau 1

THERMOVISCOUS ACOUSTICS MODEL

Bulk viscosity muB Pa·s

Density rho kg/m3

Dynamic viscosity mu Pa·s
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Electrochemistry Material Properties

These material property groups for electrochemistry (including their associated 
physical properties) can be added to models from the Material window. These property 
groups are used by the Batteries & Fuel Cells Module, Corrosion Module, 
Electrochemistry Module, and Electrodeposition Module.

Heat capacity at constant pressure Cp J/(kg·K)

Thermal conductivity k W/(m·K)

VISCOUS MODEL

Bulk viscosity muB Pa·s

TABLE 2-7:  ELECTROCHEMISTRY MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

EQUILIBRIUM POTENTIAL

Equilibrium potential Eeq V

Reference concentration cEeqref mol/m3

Temperature derivative of 
equilibrium potential

dEeqdT V/K

ELECTROLYTE CONDUCTIVITY

Electrolyte conductivity sigmal S/m

ELECTROLYTE SALT CONCENTRATION

Electrolyte salt concentration cElsalt mol/m3

LINEARIZED RESISTIVITY This material node defines the electric resistivity 
(and conductivity) as a linear function of 
temperature.

Reference resistivity rho0 Ω·m

Reference temperature Tref K

Resistivity temperature coefficient alpha 1/K

OPERATIONAL ELECTRODE 
STATE-OF-CHARGE

Maximum electrode 
state-of-charge

socmax 1

Minimum electrode 
state-of-charge

socmin 1

TABLE 2-6:  ACOUSTICS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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Electromagnetic Models

These material property groups for various electromagnetic material models (including 
their associated physical properties) can be added to models from the Material window. 
These property groups are used by the AC/DC Module, RF Module, and Wave Optics 
Module.

SPECIES PROPERTIES 

Transport number transNum 1

TABLE 2-8:  ELECTROMAGNETIC MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

B-H CURVE This material node is only available with the 
AC/DC Module.

Local Properties normH -

Magnetic flux density norm normB T

DIELECTRIC LOSSES

Dielectric loss factor eta_epsilon -

Relative permittivity (imaginary part) epsilonBis 1

Relative permittivity (real part) epsilonPrim 1

E-J CHARACTERISTIC This material node is only available with the 
AC/DC Module.

Electric field norm normE V/M

Local Properties normJ -

EFFECTIVE B-H CURVE This material node is only available with the 
AC/DC Module.

Local Properties normHeff -

Magnetic flux density norm normBeff T

EFFECTIVE H-B CURVE This material node is only available with the 
AC/DC Module.

Local Properties normBeff -

Magnetic field norm normHeff A/m

H-B CURVE This material node is only available with the 
AC/DC Module.

Local Properties normB -

TABLE 2-7:  ELECTROCHEMISTRY MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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Magnetic field norm normH A/m

JILES-ATHERTON MODEL PARAMETERS This material node is only available with the 
AC/DC Module.

Maximum magnetization parameter MsJA (3x3 matrix) A/m

Langevin slope parameter aJA (3x3 matrix) A/m

Pinning parameter kJA (3x3 matrix) A/m

Reversibility parameter cJA (3x3 matrix) 1

Interdomain coupling parameter alphaJA (3x3 matrix) 1

LINEARIZED RESISTIVITY This material node defines the electric 
resistivity (and conductivity) as a linear 
function of temperature.

Reference resistivity rho0 Ω·m

Reference temperature Tref K

Resistivity temperature coefficient alpha 1/K

LOSS TANGENT, LOSS ANGLE This material node assumes zero 
conductivity.

Loss tangent, loss angle delta rad

Relative permittivity (real part) epsilonPrim 1

LOSS TANGENT, DISSIPATION FACTOR This material node assumes zero 
conductivity.

Loss tangent, dissipation factor tanDelta 1

Relative permittivity (real part) epsilonPrim 1

MAGNETIC LOSSES

Relative permeability (imaginary part) murBis -

Relative permeability (real part) murPrim -

REFRACTIVE INDEX This material node assumes a relative 
permeability of unity and zero conductivity. 
This material node is only available with the 
RF Module or the Wave Optics Module.

Refractive index, imaginary part ki -

Refractive index n 1

REMANENT FLUX DENSITY This material node is only available with the 
AC/DC Module.

TABLE 2-8:  ELECTROMAGNETIC MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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Equilibrium Discharge

These material property groups for all the material models in the Equilibrium 
Discharge (including their associated physical properties) can be added to models from 
the Material window. These property groups are used by the Plasma Module.

Gas Models

This material property group for an ideal gas (including its associated physical 
properties) can be added to models from the Material page.

Geometric Properties (Shell)

The Shell material property group is used in connection with layered materials (it is, for 
example, added when you add a Material node by choosing  Single Layer Material 
from the Layers submenu on the Materials node’s context menu. This property group 

Recoil permeability murec 1

Remanent flux density norm normBr T

TABLE 2-9:  EQUILIBRIUM DISCHARGE MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

RADIATION HEAT TRANSFER

Total volumetric emission 
coefficient

Qrad W/m3

TABLE 2-10:  GAS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

IDEAL GAS

Heat capacity at constant pressure Cp J/(kg·K)

Mean molar mass Mn kg/mol

Ratio of specific heats gamma 1

Specific gas constant Rs J/(kg·K)

TABLE 2-8:  ELECTROMAGNETIC MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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contains geometric properties for the definition of a layer in the Layer Definition 
section.

Magnetostrictive Models

These material property groups for various magnetostrictive material models 
(including their associated physical properties) can be added to models from the 
Material window. These property groups are used by the AC/DC Module.

TABLE 2-11:  SHELL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

SHELL

Thickness lth m

Rotation lrot rad/mol

Mesh elements lne 1

TABLE 2-12:  MAGNETOSTRICTIVE MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

MAGNETOSTRICTIVE

Saturation magnetization Ms A/m

Initial magnetic susceptibility chi 1

Saturation magnetostriction lambdas 1

Magnetostriction constants lambda100 1

Magnetostriction constants lambda111 1

STRAIN-MAGNETIZATION FORM This material node is only available with the 
AC/DC Module.

Compliance matrix sH (6x6 matrix) 1/Pa

Loss factor for compliance matrix sH eta_sH (6x6 matrix) 1

Piezomagnetic coupling matrix dHT (3x6 matrix) m/A

Relative permeability murT (3x3 matrix) 1

STRESS-MAGNETIZATION FORM This material node is only available with the 
AC/DC Module.

Elasticity matrix cH (6x6 matrix) Pa

Loss factor for elasticity matrix cH eta_cH (6x6 matrix) 1

Piezomagnetic coupling matrix eHS (3x6 matrix) T

Relative permeability murS (3x3 matrix) 1
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Piezoelectric Models

These material property groups for piezoelectric materials (including their associated 
physical properties) can be added to models from the Material window. These property 
groups are used by the Acoustics Module, MEMS Module, or Structural Mechanics 
Module.

Piezoresistive Models

These material property groups for piezoresistive materials (including their associated 
physical properties) can be added to models from the Material window. These property 
groups are used by the MEMS Module.

TABLE 2-13:  PIEZOELECTRIC MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

STRAIN-CHARGE FORM

Compliance matrix sE 1/Pa

Coupling matrix dET C/N

Loss factor for compliance 
matrix

sE 1

Loss factor for coupling matrix d 1

Loss factor for electrical 
permittivity

εT 1

Relative permittivity epsilonrT 1

STRESS-CHARGE FORM

Coupling matrix eES C/m2

Elasticity matrix cE Pa

Loss factor for elasticity matrix cE 1

Loss factor for coupling matrix e 1

Loss factor for electrical 
permittivity

εS 1

Relative permittivity epsilonrS 1

TABLE 2-14:  GAS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

ELASTORESISTANCE FORM

Elastoresistive coupling matrix ml Ω·m
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Semiconductors Material Properties

These material property groups for all the material models in semiconductors 
(including their associated physical properties) can be added to models from the 
Material window. These property groups are used by the Semiconductor Module.

PIEZORESISTANCE FORM

Piezoresistive coupling matrix Pil A/m2

TABLE 2-14:  GAS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

The Property Group, Variable Names, and SI Unit columns are applicable 
to all materials in the Semiconductor Module. However, the Values and 
References columns listed in Table 2-15 are specifically for silicon in the 
COMSOL Multiphysics Reference Manual.

TABLE 2-15:  SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR 
SILICON

PROPERTY GROUP AND 
PROPERTY (ALL 
MATERIALS)

NAME/VARIABLE (ALL 
MATERIALS)

SI UNIT VALUE FOR 
SILICON

REFERENCE 
FOR 
SILICON

BASIC

Relative permittivity epsilonr 1 11.7 Ref. 1

Thermal 
conductivity

k W/(m·K) 131 W/(m·K) Ref. 1

Density rho kg/m3 2329 kg/m3 Ref. 1

Heat capacity at 
constant pressure

Cp J/(kg·K) 700 J/(kg·K) Ref. 1

BAND-GAP NARROWING MODELS>JAIN-ROULSTON MODEL

Jain-Roulston 
coefficient (n-type), 
A

An_jr V 3.5·10-8 V Ref. 12

Jain-Roulston 
coefficient (n-type), 
B

Bn_jr V 0 V Ref. 12

Jain-Roulston 
coefficient (n-type), 
C

Cn_jr V 0 V Ref. 12
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Jain-Roulston 
coefficient (p-type), 
A

Ap_jr V 3.5·10-8 V Ref. 12

Jain-Roulston 
coefficient (p-type), 
B

Bp_jr V 0 V Ref. 12

Jain-Roulston 
coefficient (p-type), 
C

Cp_jr V 0 V Ref. 12

Band-gap narrowing 
reference 
concentration

Nref_jr 1/m3 1 1/cm3 Ref. 12

Conduction band 
fraction

alpha_jr 1 0.5 Ref. 12

BAND-GAP NARROWING MODELS>SLOTBOOM MODEL

Band-gap narrowing 
reference energy

Eref_sb V 0.00692 V Ref. 11

Band-gap narrowing 
reference 
concentration

Nref_sb 1/m3 1.3·1017 1/
cm3

Ref. 11

Conduction band 
fraction

alpha_sb 1 0.5 Ref. 11

GENERATION-RECOMBINATION>AUGER RECOMBINATION

Auger 
recombination 
factor, electrons

Cn m6/s 2.8·10-31 cm6

/s
(valid at 
300 K)

Ref. 2

Auger 
recombination 
factor, holes

Cp m6/s 9.9·10-32 cm6

/s
(valid

at 300 K)

Ref. 2

GENERATION-RECOMBINATION>DIRECT RECOMBINATION

Direct 
recombination factor

C m3/s 0 m3/s N/A

TABLE 2-15:  SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR 
SILICON

PROPERTY GROUP AND 
PROPERTY (ALL 
MATERIALS)

NAME/VARIABLE (ALL 
MATERIALS)

SI UNIT VALUE FOR 
SILICON

REFERENCE 
FOR 
SILICON
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GENERATION-RECOMBINATION>IMPACT IONIZATION

a factor, electrons, 
impact ionization

an 1/V 0.426 1/V Ref. 3

a factor, holes, 
impact ionization

ap 1/V 0.243 1/V Ref. 3

b factor, electrons, 
impact ionization

bn V/m 4.81·105 V/
cm

Ref. 3

b factor, holes, 
impact ionization

bp V/m 6.53·105 V/
cm

Ref. 3

c factor, electrons, 
impact ionization

cn 1/KValues 3.05·10-4 1/K Ref. 3

c factor, holes, 
impact ionization

cp 1/K 5.35·10-4 1/K Ref. 3

d factor, electrons, 
impact ionization

dn 1/K 6.86·10-4 1/K Ref. 3

d factor, holes, 
impact ionization

dp 1/K 5.67·10-4 1/K Ref. 3

GENERATION-RECOMBINATION>SHOCKLEY-READ-HALL RECOMBINATION

Electron lifetime, 
SRH 

taun s 10 μs Ref. 4

Hole lifetime, SRH taup s 10 μs Ref. 4
MOBILITY MODELS>ARORA MOBILITY MODEL

Electron mobility 
reference

mun0_ref_arora m2/(V·s) 1252 cm2/
(V·s)

Ref. 5

Hole mobility 
reference

mup0_ref_arora m2/(V·s) 407 cm2/(V·s) Ref. 5

Electron mobility 
reference minimum

mun_min_ref_arora m2/(V·s) 88 cm2/(V·s) Ref. 5

Hole mobility 
reference minimum

mup_min_ref_arora m2/(V·s) 53.4 cm2/
(V·s)

Ref. 5

Electron reference 
impurity 
concentration

Nn0_ref_arora 1/m3 1.26·10171/
cm3

Ref. 5

TABLE 2-15:  SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR 
SILICON

PROPERTY GROUP AND 
PROPERTY (ALL 
MATERIALS)

NAME/VARIABLE (ALL 
MATERIALS)

SI UNIT VALUE FOR 
SILICON

REFERENCE 
FOR 
SILICON
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Hole reference 
impurity 
concentration

Np0_ref_arora 1/m3 2.35·10171/
cm3

Ref. 5

Alpha coefficient alpha0_arora 1 0.88 Ref. 5

Mobility reference 
minimum exponent

beta1_arora 1 -0.57 Ref. 5

Mobility reference 
exponent

beta2_arora 1 -2.33 Ref. 5

Impurity 
concentration 
reference exponent

beta3_arora 1 2.4 Ref. 5

Alpha coefficient 
exponent

beta4_arora m2/(V·s) -0.146 Ref. 5

Reference 
temperature

Tref_arora K 300 K Ref. 5

MOBILITY MODELS>CAUGHEY-THOMAS MOBILITY MODEL

Electron alpha 
coefficient

alphan0_ct 1 1.11 Ref. 6

Electron alpha 
exponent

betan1_ct 1 0.66 Ref. 6

Electron saturation 
velocity

vn0_ct m/s 1·107 cm/s Ref. 6

Electron velocity 
saturation exponent

betan2_ct 1 -0.87 Ref. 6

Hole alpha 
coefficient

alphap0_ct 1 1.21 Ref. 6

Hole alpha exponent betap1_ct 0.17 Ref. 6

Hole saturation 
velocity

vp0_ct m/s 8.37·106 cm/s Ref. 6

Hole velocity 
saturation exponent

betap2_ct 1 -0.52 Ref. 6

Reference 
temperature

Tref_ct K 300 K Ref. 6

TABLE 2-15:  SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR 
SILICON

PROPERTY GROUP AND 
PROPERTY (ALL 
MATERIALS)

NAME/VARIABLE (ALL 
MATERIALS)

SI UNIT VALUE FOR 
SILICON

REFERENCE 
FOR 
SILICON
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MOBILITY MODELS>FLETCHER MOBILITY MODEL

Fletcher mobility 
coefficient 1

F1_fl 1/(cm·V·s) 1.04×1021 1/
(cm·V·s)

Ref. 7

Fletcher mobility 
coefficient 2

F2_fl 1/m2 7.45×1013 1/
cm2

Ref. 7

Reference 
temperature

Tref_fl K 300 K Ref. 7

MOBILITY MODELS>LOMBARDI SURFACE MOBILITY MODEL

Electron delta 
coefficient

deltan_ls V/s  5.82 x 1014 
V/s

Ref. 8

Electron mobility 
reference

mun1_ls m2/(V·s) 4.75 x 
107cm2/(V·s)

Ref. 8

Electron mobility 
reference

mun2_ls m2/(V·s) 1.74 x 105 
cm2/(V·s)

Ref. 8

Electron alpha 
coefficient

alphan_ls 1 0.125 Ref. 8

Hole delta 
coefficient

deltap_ls V/s 2.05 x 1014 V/
s

Ref. 8

Hole mobility 
reference

mup1_ls m2/(V·s) 9.93 x 107 
cm2/(V·s)

Ref. 8

Hole mobility 
reference

mup2_ls m2/(V·s) 8.84 x 105 
cm2/(V·s)

Ref. 8

Hole alpha 
coefficient

alphap_ls 1 0.0317 Ref. 8

Reference 
temperature

Tref_ls K 1 K Ref. 8

Electric field 
reference

Eref_ls V/m 1 V/cm Ref. 8

Doping 
concentration 
reference

Nref_ls 1/m3 1 1/cm3 Ref. 8

MOBILITY MODELS>POWER LAW MOBILITY MODEL

Electron mobility 
reference

mun0_pl m2/(V·s) 1448 cm2/
(V·s)

Ref. 5

TABLE 2-15:  SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR 
SILICON

PROPERTY GROUP AND 
PROPERTY (ALL 
MATERIALS)

NAME/VARIABLE (ALL 
MATERIALS)

SI UNIT VALUE FOR 
SILICON

REFERENCE 
FOR 
SILICON
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Solid Mechanics Material Properties

These material property groups for material models in solid mechanics (including their 
associated physical properties) can be added to models from the Material window. Most 
of these properties are used by the Structural Mechanics Module. The property groups 
of the external material are of a special type that depends on the selected interface type 
and are not individually documented. 

Hole mobility 
reference

mup0_pl m2/(V·s) 473 cm2/(V·s) Ref. 5

Electron exponent alphan_pl 1 2.33 Ref. 5

Hole exponent alphap_pl 1 2.23 Ref. 5

Reference 
temperature

Tref_pl K 300 K Ref. 5

SEMICONDUCTOR MATERIAL

Band gap Eg0 V 1.12 V
(valid at 
300 K)

Ref. 1

Effective density of 
states, conduction 
band

Nc 1/m3 2.8×1019 1/
cm3

×(T/300 K)3/2 

Ref. 1

Effective density of 
states, valence band

Nv 1/m3 1.04×1019 1/
cm3

×(T/300 K)3/2

Ref. 1

Electron affinity chi0 V 4.05 V Ref. 1

Electron mobility mun m2/(V·s) 1450 cm2/
(V·s)

Ref. 1

Hole mobility mup m2/(V·s) 500 cm2/(V·s) Ref. 1

TABLE 2-16:  SOLID MECHANICS MATERIALS 

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

LINEAR ELASTIC MATERIAL

ANISOTROPIC

Elasticity matrix D Pa

Loss factor for elasticity matrix D eta_D 1

TABLE 2-15:  SEMICONDUCTOR MATERIAL PROPERTIES (ALL MATERIALS) AND VALUES AND REFERENCES FOR 
SILICON

PROPERTY GROUP AND 
PROPERTY (ALL 
MATERIALS)

NAME/VARIABLE (ALL 
MATERIALS)

SI UNIT VALUE FOR 
SILICON

REFERENCE 
FOR 
SILICON
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ANISOTROPIC, VOIGT NOTATION

Elasticity matrix, Voigt notation DV0 Pa

Loss factor for elasticity matrix D, Voigt notation eta_DVo 1

BULK MODULUS AND SHEAR MODULUS

Bulk modulus K N/m2

Shear modulus G N/m2

LAMÉ PARAMETERS

Lamé parameter λ lambLame N/m2

Lamé parameter μ muLame N/m2

ORTHOTROPIC

Young’s modulus Evector Pa

Poisson’s ratio nuvector 1

Shear modulus Gvector N/m2

Loss factor for orthotropic Young’s modulus eta_Evector 1

Loss factor for orthotropic shear modulus eta_Gvector 1

ORTHOTROPIC, VOIGT NOTATION

Shear modulus, Voigt notation GvectorVo N/m2

Loss factor for orthotropic shear modulus, Voigt notation eta_GvectorVo 1

PRESSURE-WAVE AND SHEAR-WAVE SPEEDS

Pressure-wave speed cp m/s

Shear-wave speed cs m/s

YOUNG’S MODULUS AND POISSON'S RATIO

Young’s modulus E Pa

Poisson’s ratio nu 1

YOUNG’S MODULUS AND SHEAR MODULUS

Young’s modulus E Pa

Shear modulus G N/m2

LINEAR VISCOELASTIC MATERIAL 

Long-term shear modulus Gv N/m2

Bulk modulus K N/m2

POROELASTIC MATERIAL

Biot-Willis coefficient alphaB 1

Porosity epsilon 1

TABLE 2-16:  SOLID MECHANICS MATERIALS 

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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Permeability kappa m2

SAFETY

ISOTROPIC STRENGTH PARAMETERS

Tensile strength sigmat Pa

Compressive strength sigmac Pa

Biaxial compressive strength sigmabc Pa

ISOTROPIC ULTIMATE STRAINS

Ultimate tensile strain epsilont 1

Ultimate compressive strain epsilonc 1

ORTHOTROPIC STRENGTH PARAMETERS, VOIGT NOTATION

Tensile strengths sigmats Pa

Compressive strengths sigmacs Pa

Shear strengths sigmass Pa

ORTHOTROPIC ULTIMATE STRAINS, VOIGT NOTATION

Ultimate tensile strains epsilonts 1

Ultimate compressive strains epsiloncs 1

Ultimate shear strains gammass 1

ANISOTROPIC STRENGTH PARAMETERS, VOIGT NOTATION

Second rank tensor, Voigt notation F_s 1/Pa

Fourth rank tensor, Voigt notation F_f m2·s4/kg2

TABLE 2-16:  SOLID MECHANICS MATERIALS 

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

• The Structural Mechanics Module User’s Guide and Table 2-19

• The Structural Mechanics Module User’s Guide and Table 2-17

• The Fatigue Module User’s Guide and Table 2-18
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Solid Mechanics Material Properties: Nonlinear Structural Materials 
Module

These material property groups for material models in solid mechanics using the 
Nonlinear Structural Materials Module (including their associated physical properties) 
can be added to models from the Material window.

TABLE 2-17:  HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

ELASTOPLASTIC MATERIAL

Hardening function sigmagh Pa

Hill’s coefficients Hillcoefficients (m2·s4)/kg2

Initial tensile and shear yield stresses ys N/m2

Initial yield stress sigmags Pa

Isotropic tangent modulus Et Pa

Kinematic tangent modulus Ek Pa

ARMSTRONG-FREDERICK

Kinematic hardening modulus Ck Pa

Kinematic hardening parameter gammak 1

CHABOCHE

Kinematic hardening modulus Ck0_cha Pa

LUDWIK

Strength coefficient k_lud Pa

Hardening exponent n_lud 1

SWIFT

Reference strain e0_swi 1

Hardening exponent n_swi 1

VOCE

Saturation flow stress sigma_voc Pa

Saturation exponent beta_voc 1

HOCKETT-SHERBY

Steady-state flow stress sigma_hoc Pa

Saturation coefficient m_hoc 1

Saturation exponent n_hoc 1

CREEP

NORTON
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Creep rate coefficient A_nor 1/s

Reference stress sigRef_nor Pa

Stress exponent n_nor 1

GAROFALO (HYPERBOLIC SINE)

Creep rate coefficient A_gar 1/s

Reference stress sigRef_gar Pa

Stress exponent n_gar 1

NABARRO-HERRING

Volume diffusivity D_nav m2/s

Burgers vector b_nav m

Grain diameter dg_nav m

COBLE

Ionic diffusivity D_cob m2/s

Burgers vector b_cob m

Grain diameter dg_cob m

WEERTMAN

Diffusivity D_wee m2/s

Burgers vector b_wee m

Stress exponent n_wee 1

Reference stress sigRef_wee Pa

VISCOPLASTIC MATERIAL

ANAND

Viscoplastic rate coefficient A_ana 1/s

Activation energy Q_ana J/mol

Multiplier of stress xi_ana 1

Stress sensitivity m_ana 1

Deformation resistance saturation coefficient s0_ana Pa

Deformation resistance initial value sa_init Pa

Hardening constant h0_ana Pa

Hardening sensitivity a_ana 1

Deformation resistance sensitivity n_ana 1

CHABOCHE

Viscoplastic rate coefficient A_cha 1/s

TABLE 2-17:  HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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Reference stress sigRef_cha Pa

Stress exponent n_cha 1

PREZYNA

Viscoplastic rate coefficient A_per 1/s

Reference stress sigRef_per Pa

POROPLASTIC MATERIAL 

Initial yield stress sigmags Pa

Shima-Oyane alpha parameter alphaShima 1

Shima-Oyane gamma parameter gammaShima 1

Shima-Oyane m parameter mShima 1

Initial void volume fraction f0 1

Critical void volume fraction fc 1

Failure void volume fraction ff 1

Tvergaard correction coefficient q1 q1GTN 1

Tvergaard correction coefficient q2 q2GTN 1

Tvergaard correction coefficient q3 q3GTN 1

Maximum void volume fraction fmax 1

NONLINEAR ELASTIC MATERIAL

Reference stress sigRef Pa

Reference strain eRef 1

Stress exponent n_stress 1

Reference shear strain gammaRef 1

Strain exponent n_strain 1

Bulk modulus in tension Kt Pa

Bulk modulus in compression Kc Pa

Ultimate deviatoric stress q_ult Pa

Ultimate strain e_ult 1

ELASTOPLASTIC SOIL MATERIAL

CAM-CLAY

Swelling index kappaSwelling 1

Compression index lambdaComp 1

Void ratio at reference pressure evoidref 1

TABLE 2-17:  HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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Slope of critical state line M 1

STRUCTURED CAM-CLAY

Swelling index for structured clay kappaSwellingS 1

Compression index for destructured clay lambdaCompS 1

Void ratio at reference pressure for destructured 
clay

evoidrefS 1

Destructuring index for volumetric deformation dvS 1

Destructuring index for shear deformation dsS 1

Slope of critical state line M 1

Additional void ratio at initial yielding Deltaei 1

Initial structure strength pbi Pa

Plastic potential shape parameter zetaS 1

Critical effective deviatoric plastic strain epdevc 1

BARCELONA BASIC

Swelling index kappaSwelling 1

Swelling index for changes in suction kappaSwellings 1

Compression index at saturation lambdaComp0 1

Weight parameter wB 1

Soil stiffness parameter mB Pa

Plastic potential smoothing parameter bB 1

Tension to suction ratio kB 1

Void ratio at reference pressure and saturation evoidref0 1

Initial yield value for suction sy0 Pa

HARDENING SOIL

Reference stiffness for primary loading E50Ref Pa

Reference stiffness for unloading and reloading EurRef Pa

Stress exponent mH 1

Bulk modulus in compression Kc Pa

Void ratio at reference pressure evoidref 1

HYPERELASTIC MATERIALS

ARRUDA-BOYCE

Macroscopic shear modulus mu0 N/m2

TABLE 2-17:  HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT



82 |  C H A P T E R  2 :  U S I N G  T H E  M A T E R I A L  L I B R A R Y

Number of segments Nseg 1

BLATZ-KO

Model parameters phiBK 1

Model parameters betaBK 1

Shear modulus muBK Pa

GAO

Model parameters aG Pa

Model parameters nG 1

GENT

Macroscopic shear modulus muG Pa

Model parameters jmG 1

MOONEY-RIVLIN

Model parameters C01, C02, C03, 
C10, C11, C12, 
C20, C21, C30

Pa

MURNAGHAN The Murnaghan node adds five 
model parameters. The model is 
based on strain invariants and is 
typically used in acoustoelasticity.

Murnaghan third-order elastic moduli l Pa

Murnaghan third-order elastic moduli m Pa

Murnaghan third-order elastic moduli n Pa

Lamé parameter λ lambLame Pa

Lamé parameter μ muLame Pa

VARGA

Model parameters c1VA Pa

Model parameters c2VA Pa

YEOH

Model parameters c1YE Pa

Model parameters c2YE Pa

Model parameters c3YE Pa

TABLE 2-17:  HYPERELASTIC AND ELASTOPLASTIC MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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Solid Mechanics Material Properties: Fatigue Module

These material property groups for material models in solid mechanics using the 
Fatigue Module (including their associated physical properties) can be added to 
models from the Material window.

TABLE 2-18:  ELASTOPLASTIC AND FATIGUE BEHAVIOR MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

ELASTOPLASTIC MATERIAL>RAMBERG-OSGOOD

Cyclic hardening coefficient K_ROcyclic Pa

Cyclic hardening coefficient n_ROcyclic 1

FATIGUE BEHAVIOR>ENERGY-BASED

DARVEAUX

Crack initiation energy coefficient K1_Darveaux 1

Crack initiation energy exponent k2_Darveaux 1

Crack propagation energy 
coefficient

K3_Darveaux m

Crack propagation energy 
exponent

k4_Darveaux 1

Reference energy density Wref_Darveaux J/m3

MORROW

Fatigue energy coefficient Wf_Morrow J/m3

Fatigue energy exponent m_Morrow 1

FATIGUE BEHAVIOR>FATIGUE BEHAVIOR>APPROXIMATE S-N CURVE

Transition stress sigmat Pa

Transition life Nt 1

Endurance life Ne 1

FATIGUE BEHAVIOR>GENERAL

Endurance limit sigmae Pa

FATIGUE BEHAVIOR>STRAIN-BASED

COFFIN-MANSON

Fatigue ductility coefficient epsilonf_CM 1

Fatigue ductility exponent c_CM 1

Shear fatigue ductility coefficient gammaf_CM 1

Shear fatigue ductility exponent cgamma_CM 1

FATEMI-SOCIE
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Solid Mechanics Material Properties: Geomechanics Material Model

These material property groups for material models in solid mechanics (including their 
associated physical properties) can be added to models from the Material window. 
These property groups are used by the Geomechanics Module.

Normal stress sensitivity 
coefficient

k_FS 1

WANG-BROWN

Normal stress sensitivity 
coefficient

S_WB 1

FATIGUE BEHAVIOR>STRESS-BASED

BASQUIN

Fatigue strength coefficient sigmaf_Basquin Pa

Fatigue strength exponent b_Basquin 1

Shear fatigue strength coefficient tauf_Basquin Pa

Shear fatigue strength exponent bgamma_Basquin 1

FINDLEY

Normal stress sensitivity 
coefficient

k_Findley 1

Limit factor f_Findley Pa

MATAKE

Normal stress sensitivity 
coefficient

k_Matake 1

Limit factor f_Matake Pa

NORMAL STRESS

Limit factor f_NormalStress Pa

DANG VAN

Hydrostatic stress sensitivity 
coefficient

a_DangVan 1

Limit factor b_DangVan Pa

TABLE 2-19:  GEOMECHANICS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

DRUCKER-PRAGER

Drucker-Prager alpha coefficient alphaDrucker 1

TABLE 2-18:  ELASTOPLASTIC AND FATIGUE BEHAVIOR MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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Thermal Expansion Material Properties

This material property group for thermal expansion properties can be added to models 
from the Material page.

Drucker-Prager k coefficient kDrucker Pa

HOEK BROWN

Hoek-Brown m parameter mHB 1

Hoek-Brown s parameter sHB 1

Geological strength index GSI 1

Disturbance factor Dfactor 1

Intact rock parameter miHB 1

LADE-DUNCAN

Lade-Duncan k coefficient kLade 1

MATSUOKA-NAKAI

Matsuoka-Nakai mu coefficient muMatsuoka 1

MOHR-COULOMB

Cohesion cohesion Pa

Angle of internal friction internalphi rad

OTTOSEN

Ottosen a parameter aOttosen 1

Ottosen b parameter bOttosen 1

Size factor k1Ottosen 1

Shape factor k2Ottosen 1

YIELD STRESS PARAMETERS

Uniaxial tensile strength sigmaut Pa

Uniaxial compressive strength sigmauc Pa

Biaxial compressive strength sigmabc Pa

TABLE 2-20:  THERMAL EXPANSION MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT

IDEAL GAS

Isotropic tangent coefficient of thermal 
expansion

alphatanIso 1/K

Isotropic thermal strain dLIso 1

TABLE 2-19:  GEOMECHANICS MODELS MATERIALS

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT
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External Material Properties

The property groups of the external materials are of a special type that depends on the 
selected interface type and are not individually documented. You can incorporate as 
many parameters in the call to the external DLL when you add an external material, 
these parameters will appear in the Material node as material inputs, see Working with 
External Materials for more information.

Tangent coefficient of thermal expansion alphatan_iso; alphatanij 1/K

Thermal strain dLi_iso, dLij 1

TABLE 2-20:  THERMAL EXPANSION MATERIAL PROPERTIES

PROPERTY GROUP AND PROPERTY NAME/VARIABLE SI UNIT



U S I N G  F U N C T I O N S  |  87

U s i n g  Fun c t i o n s

The Material Library describes material properties with functions, usually functions of 
temperature, and for this purpose it uses piecewise analytic functions (polynomials). 
For user-defined property functions, three types of functions can be defined: analytic 
functions, piecewise analytic functions, and interpolation functions.

Functions are useful for describing material properties as, for example, functions of 
temperature or pressure.

Adding a Function to the Material

Material functions are either automatically added to the Model Builder sequence 
(usually with materials from the material library) or functions can be added based on 
individual requirements.

1 Add a material to the Component node (see The Material Browser Window and The 
Add Material Window).

2 Add an Analytic ( ), Interpolation ( ), or Piecewise ( ) function.

To add an Analytic ( ), Interpolation ( ), or Piecewise ( ) function:

• On the Materials toolbar, click Analytic, Interpolation, or Piecewise. 

• Right-click a property group node (for example, Basic) and select a 
function from the Functions list.

To add an Analytic ( ), Interpolation ( ), or Piecewise ( ) function:

• Right-click a property group node, for example, Basic and select a 
function from the Functions list.

• On the Materials contextual toolbar, click Analytic, Interpolation, or 
Piecewise.
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- Select Analytic to add an analytic function of one or more input arguments.

- Select Interpolation to add an interpolation function that can interpolate from 
structured data (defined on a grid) or unstructured data (defined on a generic 
point cloud). 

- Select Piecewise to add a piecewise function that is useful if a material property has 
different definitions on different intervals. The intervals must not overlap, and 
there cannot be any holes between intervals.

Defining an Analytic Function

Assume that you want to define the density ρ1 for a material as a function of pressure 
and temperature: ρ1= ρ1(p,T). You can name the function rho1(p,T) and use the 
expression p*0.02897/8.314/T to define the function.

1 On the Materials toolbar, click the Browse Materials , Add Material , or Blank 

Material  button to add a new material to the Component (or use an existing 
material where density is not defined, or redefine the current expression for the 
density). 

2 Add a Density property to the material.

a In the Model Builder, click the Material node.

b In the Settings window for Material, click to expand the Material Properties 
section. Under Basic Properties, right-click Density and Add to Material.

A Density property is added to the Basic property group.

3 In the Model Builder, under the material node, right-click Basic and select 
Functions>Analytic. This adds an Analytic subnode ( ) under Basic.

4 On the Settings window for Analytic, enter rho1 in Function name. Replace the 
default name.

• Defining an Analytic Function

• Analytic, Interpolation, and Piecewise in the COMSOL Multiphysics 
Reference Manual

Once a function is created, you can use it for any property in the same 
property group.
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5 Under the Definition section:

a In the Expression field, enter p*0.02897/8.314/T.

b In the Arguments column, enter p,T.

6 Under Units:

a In the Arguments field, enter Pa, K as the units for the pressure and the 
temperature, respectively.

b In the Function field, enter kg/m^3 as the unit for the function’s output (density). 
The function rho1 can now be used to define the density in your material.

7 Click the Material node. In the Settings window for Material, under Material Contents, 
enter rho1(p,T) in the Value column (in the Density row).

Click the Basic node to notice that the Density analytic function is defined in the 
Settings window for Property Group under Output Properties. The expression will be 
orange if there are no variables p and T for pressure and temperature, respectively, 
defined in the component. See Figure 2-13.
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Figure 2-13: A density property is defined using an analytic function.
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